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About your system

The GigaVUE-FM Appliance is a 1U, dual socket rack system that supports:

@®Two Intel Xeon Scalable Processors

@16 DIMM slots

@8 x 2.5-inch drives.

@®Two redundant power supply units (PSU)

The GigaVUE-FM Appliance has two models which are as follows :

« GFM-HW1-FMOI10 - This model includes a ten node license.
« GFM-HW1-FMOO1-HW- This model does not include a ten-node license.

Front View of the System

The front view of the chassis displays the following components.

8 x 2.5-inch drive system

Item Ports, panels, Icon Description
and slots
1 Left control N/A Contains the system health and system ID, status LED, and the iDRAC
panel Quick Sync 2 (wireless) indicator.
@®Status LED: Enables you to identify any failed hardware components.
There are five status LED’s and an overall system health LED (Chassis
health and system ID) bar. For more information, see the Status LED
indicators section.
2 Optical drive N/A Slot for slim SATA DVD-ROM drive or DVD+/-RW drive.
(Not Installed)
3 VGA port o Enables you to connect a display device to the system.
Right control Contains the power button, USB port, iDRAC Direct micro port, and
4 panel N/A the iDRAC Direct status LED.
Drive slots N/A Enable you to install drives that are supported on your system.

About your system
Front View of the System
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Left Control Panel View

Item Indicator, button, or connector Icon Description
1 Status LED indicators N/A Indicate the status of the system.
2 System health and system ID indicator i Indicates the system health.

Status LED indicators

‘ NoTE: The indicators display solid amber if any error occurs.

Table 5. Status LED indicators and descriptions

Icon Description Condition Corrective Action
E_J Drive indicator The indicator turns solid amber, if there @®Check the System event log to
is a drive error. determine if the drive has an error.

@®Run the appropriate Online
Diagnostics test. Restart the system,
and run embedded diagnostics
(ePSA).

@|If the drives are configured in a
RAID array, restart the system, and
enter the host adapter configuration
utility program.

3 Temperature The indicator turns solid amber, if the Ensure that none of the following
indicator system experiences a thermal error (for conditions exist:
example, the ambient temperature is ® A cooling fan has been removed or
out of range or there is a fan failure). has failed.

@ System cover, air shroud, or back
filler bracket is removed.

@® Ambient temperature is too high.
@®External airflow is obstructed.

About your system 8
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Icon Description Condition Corrective Action
Electrical The indicator turns solid amber, if the Check the System event log or
indicator system experiences an electrical error system messages for the specific
(for example, voltage out of range, or a issue. If it is due to a problem with
failed power supply unit (PSU) or voltage | the PSU, check the LED on the PSU.
regulator). Reseat the PSU.
u Memory The indicator turns solid amber if a Check the System event log or
indicator memory error oCcCcurs. system messages for the location of

the failed memory. Reseat the
memory module.

PCle indicator The indicator turns solid amber, if a PCle | Restart the system. Update any
card experiences an error. required drivers for the PCle card.
Reinstall the card.

Right Control Panel View

Table 8. Right control panel

Item Indicator or Button Icon Description

1 Power button O Indicates if the system is powered on or off.
Press the power button to manually power
on or off the system.

Press the power button to gracefully shut
down an ACPI-compliant operating system.

2 USB port = The USB ports are 4-pin, 2.0- compliant.
This port enables you to connect USB
devices to the system.

3 iDRAC Direct LED N/A The iDRAC Direct LED indicator lights up to
indicate that the iDRAC Direct port is
actively connected to a device

4 iDRAC Direct port (Micro-AB USB) 5% The iDRAC Direct (Micro- USB) AB USB)
port enables you to access the iDRAC
Direct (Micro-AB) features.

Back View of the System

The back view displays the features available on the back of the system.

About your system 9
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4

5

Ports, panels, or slots

=

Description

1 Serial port

o101

Use the serial port to connect a
serial device to the system.

2 iDRAC9 dedicated network port

N/A

Use the iDRACY dedicated network
port to securely access the
embedded iDRAC on a separate
management network.

3 Ethernet ports (2)

Use the Ethernet ports to connect
Local Area Networks (LANs) to the
system.

4 Low profile riser right slot

N/A

Use the card slot to connect half-
height PCle expansion card on low
profile riser.

5 Low profile riser left slot

N/A

Use the card slot to connect half-
height PCle expansion card on low
profile riser.

6 Power supply unit (PSU)

N/A

For more information about the PSU
configurations, see the PowerEdge
R440 Technical Specs.

7 Power supply unit (PSU)

N/A

For more information about the PSU
configurations, see the PowerEdge
R440 Technical Specs.

8 USB 3.0 port (2)

Use the USB 3.0 port to connect USB
devices to the system. These ports
are 4-pin, USB 3.0-compliant.

About your system
Back View of the System
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Item Ports, panels, or slots Icon Description

9 VGA port = Use the VGA port to connect a
display to the system.

10 System status indicator cable port N/A Enables you to connect the status
indicator cable and view system
status when the CMA is installed.

n System identification button @ Press the system ID button:

@To locate a particular system
within a rack.

@®To turn the system ID on or off. To
reset iDRAC, press and hold the
button for more than 15 seconds.
NOTE: To reset iDRAC using system
ID, ensure that the system ID button
is enabled in the iDRAC setup.

LCD Panel

The LCD panel provides system information, status, and error messages to indicate if the
system is functioning correctly or requires attention. The LCD panel can also be used to
configure or view the system’s iDRAC |IP address.

The LCD panel is available only on the optional front bezel. The optional front bezel is hot
pluggable. The statuses and conditions of the LCD panel are outlined here:

@®The LCD backlight is white during normal operating conditions.

@®\When the system needs attention, the LCD backlight turns amber, and displays an error
code followed by descriptive text.

NoOTE: If the system is connected to a power source and an error is detected, the
LCD turns amber regardless of whether the system is turned on or off.

@®\When the system turns off and there are no errors, LCD enters the standby mode after five
minutes of inactivity. Press any button on the LCD to turn it on.

@ If the LCD panel stops responding, remove the bezel and reinstall it.

@®The LCD backlight remains off if LCD messaging is turned off using the iDRAC utility, the
LCD panel, or other tools.

About your system 1
LCD Panel
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> |P:23.75.248.127

12 3 4

Item Button or Description
display
1 Left Moves the cursor back in one-step increments.
2 Select Selects the menu item highlighted by the cursor.
Right Moves the cursor forward in one-step increments. During message scrolling:

@® Pressand hold the right button to increase scrolling speed.
@® Release the button to stop.

The display stops scrolling when the button is released. After 45 seconds of
inactivity, the display starts scrolling.

4 LCD display Displays system information, status, and error messages or iDRAC IP address.

Viewing Home screen

The Home screen displays user-configurable information about the system. This screen is
displayed during normal system operation when there are no status messages or errors.
When the system turns off and there are no errors, LCD enters the standby mode after five
minutes of inactivity. Press any button on the LCD to turn it on.

1. To view the Home screen, press one of the three navigation buttons (Select, Left, or
Right).

2. To navigate to the Home screen from another menu, complete the following steps:
a. Press and hold the navigation button until the up arrow L is displayed.
b. Navigate to the Home icon # using the up arrowt .
c. Select the Home icon.

d. On the Home screen, press the Select button to enter the main menu.

Setup menu

NoTE: When you select an option in the Setup menu, you must confirm the option
before proceeding to the next action.

About your system 12
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Option Description

iDRAC

Select DHCP or Static IP to configure the network mode. If Static IP is selected, the available
fields are IP, Subnet (Sub), and Gateway (Gtw). Select Setup DNS to enable DNS and to view
domain addresses. Two separate DNS entries are available

Set error

Select SEL to view LCD error messages in a format that matches the IPMI description in the
SEL. This enables you to match an LCD message with an SEL entry. Select Simple to view
LCD error messages in a simplified user-friendly description.

Set home

Select the default information to be displayed on the Home screen. See View menu for the
options and option items that can be set as the default on the Home screen.

View menu

NoTE: When you select an option in the View menu, you must confirm the option
before proceeding to the next action.

Option Description

iDRAC IP Displays the IPv4 or IPve addresses for iDRAC9. Addresses include DNS (Primary and
Secondary), Gateway, IP, and Subnet (IPv6 does not have Subnet).

MAC Displays the MAC addresses for iDRAC, iSCSI, or Network devices.

Name Displays the name of the Host, Model, or User String for the system.

Number Displays the Asset tag or the Service tag for the system

Power Displays the power output of the system in BTU/hr or Watts. The display format can be
configured in theSet home submenu of the Setup menu.

Temperature Displays the temperature of the system in Celsius or Fahrenheit. The display format can be
configured in the Set home submenu of the Setup menu.

About your system
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Configuring the GigaVUE-FM
Appliance

This section provides the procedures for making the physical connections to the appliance
and how to access and configure the GigaVUE-FM application after the appliance is
powered up.

Connecting to the Network

After installing the GigaVUE-FM Appliance, you will need to connect to your management
switch or switches to access to the GigaVUE-FM application and use iDRAC for managing
the appliance remotely.

Prerequisites

« Ethernet cables

Connecting to GigaVUE-FM

1. Locate Ethernet connector 1 on the rear panel and plug in the Ethernet cable. This is
used for ethO.

2. Connect the other end of the cable to the management switch.
3. Locate the iDRAC port on the back panel and plug in the second Ethernet cable.

4, Connect the second Ethernet cable to the same management switch. You can connect
to a different management switch if you want to access iDRAC from a different subnet.

5. Connect the peripherals to the appliance if you plan to configure the GigaVUE-FM
application locally.

6. Power on the appliance manually if you will use the peripherals connected to the
appliance to configure the GigaVUE-FM application.

7. Remote power on can be done through iDRAC.

Configuring to the GigaVUE-FM

You can configure the GigaVUE-FM application that is pre-installed on the appliance by
connecting peripherals to the appliance and powering it on. Once the appliance is powered
on you can log in to GigaVUE-FM and run the configuration jump-start program.

NoTE: The USB ports on the front panel of the GigaVUE-FM Appliance are disabled.

Configuring the GigaVUE-FM Appliance 14
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1. Connect the mouse and key board to the USB ports on rear panel.

2. Connect the monitor to the video connector on the rear panel.

NoTE: Use this procedure if you want to configure the GigaVUE-FM application
directly from the appliance.

Powering on the Appliance Manually

The following procedure is used to manually power on the appliance. You can also power on
the appliance through iDRAC.

1. Remove the front bezel.
2. Press the power button located in the upper-left corner of the front panel.
3. Replace the front bezel.

4. Log.

Logging in to the GigaVUE-FM application from
the appliance

1. Power on the appliance. See Powering on the Appliance Manually. The appliance will boot
up and load the software. When it is completed, you will see the login screen for GigaVUE-
FM.

2. At the login prompt, enter admin.
3. When the system prompts for a password, enter admin123Al!

The system will automatically run the configuration jump-start script the first time you log
in.

Accessing the Appliance Remotely

You can manage the GigaVUE-FM appliance remotely through iDRAC. iDRAC is always
available where there is power to the system. This allows you to power on/off the host and
connect through the Integrated Remote Access Controller Ul with a Web browser. Before
you can access the appliance remotely, you need the iDRAC IP address.

1. Locate the LCD display on the front panel.
2. Click the Select button.
3. When you see the Home icon, click the Right button to select the View menu.

4. Click the Select button to choose the iDRAC menu.

Configuring the GigaVUE-FM Appliance 15
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5. Click the Select button to choose IPv4.
6. Record the IPv4 address.

Powering on the Appliance through iDRAC

The following is the procedure for powering on the appliance through the iDRAC connect.
This allows you to power on/off the device remotely.

1. Login tothe iDRAC interface.

a. Open a Chrome browser and enter the IP address in the URL field. The following
screen displays in the browser.

Integrated Remote Access Controller 9

iDRAC-7Z43RJ3 | | Enterprise

Type the User Name and Password and click Log In.

Username: Password: @

Domain:

This IDRAC ~

b. Enter the default username and password (root, admin123Al).
c. Click Submit.

a. Enter the default username and password (root, admini123Al).

NoTE: It is highly recommended that you change the default password.

2. The Integrated Remote Access Controller displays.

Configuring the GigaVUE-FM Appliance
Logging in to the GigaVUE-FM application from the appliance
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= KDRACY | Enterprise Search °l = 2 0
=1

#A Dashboard System S Storage v ili Configuration » Maintenance 2. iDRAC Settings Vs
Dashboard
X C' Refresh
@ Graceful Shutdown | ~ LEDOn ~ More Actions ~
Health Information [l System Information [ Task Summary View All Jobs
Power State ON Pending Jobs : 0
© SYSTEM HAS CRITICAL ISSUES
Model No Pending Jobs
Host Name
System Health Storage Health
Operating System
© Critical  Details Healthy Detailsh peratng =y @ In-Progress Jobs : 0
ol n— Operating System Version e (7 Piegress s
©  Power Supplies Service Tag 7Z43RJ3
BIOS Version 2122
) ) . © Completed Jobs : 17
iDRAC Firmware Version 4.40.40.00
1 with Errors
IP Address(es) 10.115.42.96

0 Failed

Running Configuration Jump Start

This section describes the configuration jump-start script that runs the first time you log in
to GigaVUE-FM. After running the configuration script, you can log in to the GigaVUE-FM Ul
from a Web browser or a remote console such as TeraTerm or PUTTY to use the command
line interface (CLI) to re-run jump-start or use other CLI commands.

The following are the steps in the configuration jump-start and an explanation of each step.
« Hosthname?

Provide a unique hostname for GigaVUE-FM. The hostname may contain letters, numbers,
periods (.), and hyphens (-), but may not begin with a hyphen. No other special characters
are permitted. This will also appear as part of the command line prompt after jump-start
completes.

« Use DHCP on ethO interface?

The default for this step in the configuration is no. If you answer yes. GigaVUE-FM acquires
the DHCP address from the local server.

« Primary IP address and masklen?

Select Yes or No to mask you Primary address.

« Default gateway?

Provide the default gateway address for reaching the management domain.

Configuring the GigaVUE-FM Appliance 17
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« Primary DNS server?

Provide the default gateway address for reaching the management domain.

« Domain name?

Enter a domain name to use instead of the |IP address to open the GigaVUE-FM login page.
For example, fmappliance.com.

« Admin password?

This sets the password for the admin user in GigaVUE-FM, which you will use to log in to for
the first time. The default is admin123Al. It is highly recommended that you change the
default password.

=« Additional Domain Name Server IP addresses?

Enter the address of any additional name servers required. This must be provided as a set of
IP addresses with spaces. For example, 10.10.10.10 11.11.11.11.

=« Additional DNS Domains?

You can add multiple DNS domains by entering the names configuration with spaces. For
example, abc.com def.com.

« Enable NTP?

If you respond yes to this option, you will be asked to provide the address of an NTP server
and its NTP version number.

When you have completed the steps in the configuration jump-start, you can change any of
the configurations by entering the step number. Otherwise, press enter to complete the
configuration.

After configuration is complete, you can log in to the GigaVUE-FM application by going to
your Web browser and entering the IP address specified during configuration jump-start in
the URL field. When the GigaVUE-FM login page opens, enter admin in the user name field
and the password you entered in step 7 of the configuration jump-start.

Configuring the GigaVUE-FM Appliance 18
Running Configuration Jump Start
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Upgrade GigaVUE-FM

This section describes how to upgrade GigaVUE-FM to the latest revision in either a VMware
ESXi host or in Microsoft HyperV environment.

E Before you upgrade, read Important GigaVUE-FM Upgrade Guidance for special
guidelines and caveats related to upgrading from specific versions of GigaVUE-FM.

At a high level, the upgrade process involves the following steps:

1. Before starting an upgrade to GigaVUE-FM, get the latest image, upgrade information,
and Release Notes from the Software & Release Notes download page (login required)
on the Gigamon Community.

2. Be sure to review the GigaVUE Release Notes for the latest release before performing
the upgrade.

e Ensure your environment supports any specified system requirements.

¢ Check the minimum memory requirements in the new release as they may change
between releases.

3. Once the GigaVUE-FM image is obtained, download it to a server within your
environment. This must be a server that your current GigaVUE-FM instance can access
to upload it.

4. (Important) Save your current configuration using the facilities provided by the
hypervisor before upgrading.

5. Verify that the GigaVUE-FM instance time is set correctly to ensure accuracy of the
trending data that is captured.

6. Perform the upgrade using either the Command-Line Interface (CLI) or the GigaVUE-
FM User Interface (Ul).

7. After upgrading your GigaVUE-FM instance, upgrade your GigaVUE-VM deployments.
Refer to “Bulk Upgrading GigaVUE-VM Nodes” in the GigaVUE Cloud Suite for
VMware—GigaVUE V Series Guide.

Upgrade Methods:

«» Upgrade GigaVUE-FM from the GigaVUE-FM CLI
« Upgrade GigaVUE-FM from the Ul

Supported Upgrade Paths for GigaVUE-FM

The supported upgrade paths for GigaVUE-FM is as follows:

o 5.8.01>510.02 > 5.11.xx*
o 59.xx>511.xx*

19

Upgrade GigaVUE-FM


https://community.gigamon.com/gigamoncp/s/swdownload

GigaVUE-FM Hardware Appliance Guide for GFM-HWI1-FMO10 and GFM-HWI1-FMQOOI1-HW

o 5.10.xx > 511.xx* or 5.12.xx**
o 5.11.xx > 512.xx* or 513.xx**

o 5.12.xx > 513.xx* or 5.14.xx**
o 5.13.xx > 514.xx** or 515.xx**
o 5.14.xx > 515xx** or 5.16.xx**
o 5.15.xx > 516.xx** or 6.0.xx**
o 5.16.xX > 6.0.XX™* or 6.1.xx**

o 6.0.xx>6.1xx*

*Password change is mandated for all passwords during upgrade.
**Password change is only mandated if the current password is using the default
password.

GigaVUE-FM Upgrade Rules and Notes

» Best Practice: Always upgrade your GigaVUE-FM instance before upgrading the
GigaVUE-OS nodes. You can upgrade the attached nodes from the device or from
GigaVUE-FM. The latter is recommended. Refer to “Upgrading Software on a GFM-HWI-
FMOI10,GFM-HWI1-FMOOI-HW Node or a Cluster from GigaVUE-FM” in the GigaVUE
Fabric Management Guide.

» If upgrading from GigaVUE-FM versions lower than 5.10.xx: You cannot directly
upgrade your GigaVUE-FM instance to release 5.10.00 from a release prior to 5.8.xx. If your
current version of GigaVUE-FM is 5.7.xx or lower and you want to upgrade to software
version 6.1.xx, you must first migrate to GigaVUE-FM 5.10.xx and then upgrade to 5.11.xx.

NOTE: For instructions on how to migrate refer to Migrate GigaVUE-FM in
GigaVUE 5.10 Documentation.

 If upgrading from GigaVUE-FM versions lower than 5.5.00: While upgrading from any
version lower than 5.5.00, an association of more than one VPort to the same GigaSMART
group needs to be removed for any existing GTP GigaSMART operation.

 If upgrading from GigaVUE-FM versions lower than 5.4.00: Be aware of the minimum
memory requirement changes between releases. Earlier releases specified 4GB of
memory for the OVA template; whereas versions after 5.4.00 require 8GB and versions
after 5.7.00 require 16GB. If the existing virtual or physical hardware running GigaVUE-FM
is configured with less memory than required, then increase the amount of memory
available to the GigaVUE-FM machine. Refer to GigaVUE-FM Memory and CPU
Requirements in the GigaVUE Release Notes for additional details.
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Important GigaVUE-FM Upgrade Guidance

To upgrade GigaVUE-FM, the recommmended procedure is to back up your current
configuration and perform the pre-upgrade checks (memory requirements, the maximum
number of images) before installing the image. You can upgrade via the GigaVUE-FM GUI or
CLI. It is recommended that you plan your upgrade before performing any upgrade steps.
Refer Supported Upgrade Paths for GigaVUE-FM for details on upgrade path.

Best Practice: Before performing an upgrade, in addition to taking a backup of GigaVUE-
FM, also take a Sysdump, which provides valuable configuration information that is not
captured in the backup. You can use the Sysdump after the upgrade to troubleshoot any
upgrade-related issues with your configurations.

GigaVUE-FM Migration Guidance

GigaVUE-FM v5.8.01 introduced several significant changes that included improvements in
usability and performance. These changes involved upgrading and replacing databases and
changing the underlying operating system. For this reason, when upgrading from any pre-
5.8.xx version of FM to version 5.8.xx or above, you must first migrate your existing
configurations and data such as audit logs, events, syslogs, and statistics from your current
pre-5.8.xx GigaVUE-FM version to GigaVUE-FM v6.1.00.

Special migration steps and supported upgrade paths are provided under Migrate GigaVUE-
FM in the 510 Documentation. After GigaVUE-FM v5.10.xx, migration is no longer needed
when upgrading to future versions. For supported upgrade paths requiring a special
migration step, see Supported GigaVUE-FM Migration and Upgrade Paths.

Upgrade GigaVUE-FM from the GigaVUE-FM CLI

The following steps describe how to upgrade an existing GigaVUE-FM deployment to the
current release.

1. Verify that only three images are present on the GigaVUE-FM server.

2. Download the new image into GigaVUE-FM using either HTTP, HTTPS, FTP, TFTP, SCP,
or SFTP.

3. Install the new image.
4. Change boot partition.
5. Upgrade GigaVUE-VM (Optional).

Notes:

21

Upgrade GigaVUE-FM


https://docs.gigamon.com/doclib510/Content/GV-FM-Install/FM_Migration.html
https://docs.gigamon.com/doclib510/Content/GV-FM-Install/FM_Migration.html
https://docs.gigamon.com/doclib510/51000-gigadoc.html
https://docs.gigamon.com/doclib510/51000-gigadoc.html#GV-FM-Install/FM_Migration.html#fm_migration_958542478_1770395

GigaVUE-FM Hardware Appliance Guide for GFM-HWI1-FMO10 and GFM-HWI1-FMQOOI1-HW

« Itisimportant that you must be a user with fm_super_admin role when upgrading the
image on the existing GigaVUE-FM.

«» GigaVUE-FM backup and restore files use a text based format; binary backups or
restore on physical nodes are not supported. For binary backups, you must use the CLI
commands rather than GigaVUE-FM. For more information about the CLI commands,
refer to the GigaVUE-OS CLI Reference Guide.

« Inyour commands use the actual file names of the image(s) you are fetching,
managing, or deploying.

Step 1: Verify that only three images are present on GigaVUE-FM server
1. To begin an upgrade, open a SSH session and log into GigaVUE-FM.

2. Check the number of images currently available for installation with the following
command from the GigaVUE-FM CLI:

$ fmctl image list

Important: If there are three images listed in the Images available to be
installed section of the fmctl image list output, Gigamon recommends you to
delete existing older images. GigaVUE-FM will display a warning if you attempt
to fetch a fourth image.

3. To delete an existing image from the server use the following command:

$ fmctl image delete <Filename>

4. Go to Step 2: Fetch the latest release of GigaVUE-FM.
Step 2: Fetch the latest release of GigaVUE-FM

Gigamon provides an FTP site where the new release image file resides. To fetch the latest
release, do the following:

1. Locate the image file for the new release.

2. Copy the image to your file server.

Use the fmctl image fetch commmand to retrieve the software image from your file
server. The CLI shows you the progress of the image fetch with a series of hash marks,
returning you to the system prompt when complete.

NoOTE: The image fetch command supports the use of HTTP, HTTPS, FTP, TFTP,
SCP, or SFTP for the transfer of images. The examples are provided to show the
syntax only. In your commands, use your actual login credentials and the actual
name of the image file you wish to fetch.

a. The following command uses SCP to retrieve the gigamon-gigavue-fm-6.1 image
image from the image server with the IP address using login and password.

fmctl image fetch <download URI> [<filename>]
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$ fmctl image fetch scp://user:password@<IP address>/gigamon-gigavue-fm-6.1.1img
b. The following command uses FTP to retrieve the same image using login and
password.
$ fmctl image fetch ftp://user:password@<IP address>/gigamon-gigavue-fm-6.1.1img
c. The following command uses TFTP to retrieve the same image without using a
password but using a DNS server instead of an |IP address for the download server.

$ fmctl image fetch tftp://myserver.gigamon.com/tftpboot/gigamon-gigavue-fm-
6.1.1img

Specify the base directory when using TFTP.

NoOTE: Fetching the image using TFTP is time consuming, due to the size of the
image and the inherent slowness of TFTP. For better performance, use SCP or
HTTP to fetch the image.

4. Go to Step 3: Install the latest release of the GigaVUE-FM.
Step 3: Install the latest release of the GigaVUE-FM

Use the image install command to install the downloaded image file. When running the
following command, the process will first verify that the filename used for the image is
suitable for installation prior to installing the image. For example, to install the image
downloaded in the previous step and provide the location for boot location for installation.

To check current boot location:

$ fmctl image show

This command lists the current boot partition, which can be 1 or 2. Use 2 if the current
partition is 1 and vice e versa.

Sfmctl image install <Filename> <Boot location>
Step 4: Change the boot partition

Set the image you just installed to boot next with the following command. This ensures that
at the next boot the latest image will be picked up.

$ fmctl image boot next
GigaVUE-FM will reboot with the next boot image and GigaVUE-FM will be upgraded.
Step 5: Upgrade GigaVUE-VM (Optional)
After upgrading GigaVUE-FM, you must also upgrade any deployed GigaVUE-VM. Otherwise,
maps may not work and the GigaVUE-VM will be unreachable. For information about

upgrading GigaVUE-VM, refer to the “Bulk Upgrading GigaVUE-VM Nodes” section in the
GigaVUE Cloud Suite for VMware—GigaVUE V Series Guide.
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Upgrade GigaVUE-FM from the Ul

This section describes the steps to upgrade GigaVUE-FM from the Ul. You can upgrade by
using an image that is located on an external image server, or you can use GigaVUE-FM as
the image server.

Keep in mind the following rules and notes before you upgrade GigaVUE-FM from the UlI:

« When using the GigaVUE-FM Ul to upgrade GigaVUE-FM, you can only upgrade to the
currently available version or to the next version. You cannot downgrade.

 When using the Firefox browser, clear the cache before upgrading to prevent issues with
the browser.

» When upgrading GigaVUE-FM to the latest image file, the upgrade operation will fail if
GigaVUE-FM already has three image files. Delete the unused image files before
proceeding to download a new image file.

NOTE: You can enable auto-purge of GigaVUE-FM images using an API. Contact
Gigamon Technical Support for assistance.

e Starting from software version 5.15.00, subsequent GigaVUE-FM upgrade operation to
higher versions deletes the upgraded GigaVUE-FM image file irrespective of the
completion status. For example, when upgrading from 5.15.00 to 5.16.00, irrespective of
whether the upgrade process fails or succeeds, GigaVUE-FM deletes the 5.16.0.0 image file
at the end of the upgrade process.

Upgrade from External Image Server

This section provides the steps for upgrading the GigaVUE-FM from an image stored on an
external server. The image can be transferred from the server to the GigaVUE-FM using
either SCP or TFTP file protocols.
To upgrade with an image stored on an external image server, do the following:

1. Upload the image to the external image server to make it available to GigaVUE-FM.

To obtain software images, register on the Gigamon Customer Portal and download
the software.

2. Add the image server to GigaVUE-FM. This stores the credentials, image file name, and
IP address of the server on GigaVUE-FM.

To add the image server:
a. On the left navigation pane, cIick.

b. Select System on the left navigation panel and go to Images > External Servers.
The External Servers page appears.

c. Click Add. The Add External Server page appears.
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d. On the Images Server page, specify the following:

An alias to help identify the image server.

The host IP address of the server.

The protocol to use for the download: SCP or TFTP.

The user name and password if you selected SCP. They are not needed for TFTP.

e. Click Save.

The External Server page displays the newly added external server. From the Admin
drop-down list in the top right corner of the window, select Upgrade to open the
FM Image Upgrade page as shown in the following figure.

Software Upgrade

Image File

Select the file server where you have uploaded the image file.

Image Server: MewExternalServer bl

= e I B ¥ )
Image File Path: {<image path>/<image name>

To monitor the progress and status of the upgrade, click “GigaVUE Administration
Guide".

3. Onthe FM Image Upgrade page, click on the Image Server field and select the server
added in Step 2.

4. Inthe Image File Path, enter the image path and filename on the external file server.
5. Upgrade any deployed GFM-HW1-FMO10,GFM-HW1-FMOO1-HW -VMs.

After upgrading GigaVUE-FM, you must also upgrade any deployed GFM-HW1-
FMO10,GFM-HW1-FMOO1-HW -VMs. Otherwise, maps may not work and the GFM-HW1-
FMO10,GFM-HW1-FMOO1-HW -VMs will be unreachable. For information about
upgrading GFM-HW1-FMO010,GFM-HW1-FMOO1-HW -VM, refer to the “Bulk Upgrading
CigaVUE-VM Nodes” section in the GigaVUE Cloud Suite for VMware—GigaVUE V
Series Guide.
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Upgrade with GigaVUE-FM as the Image Server

This section provides the steps for upgrading GigaVUE-FM when GigaVUE-FM is used as the
file server instead of an external server.

Upgrading from GigaVUE-FM 5.6.01 to 5.7.xx.00 or 5.7.01 via an internal image will not work
because internal server storage does not function during the upgrade procedure.
Alternatively, you can upgrade using an external image server or the GigaVUE-FM CLI or you
can use the GigaVUE-FM internal storage to store the GigaVUE-FM image, and point to it as
if it were an external server as follows:

1. Add the GigaVUE-FM 5.7 image under the GigaVUE-FM internal image server
(/config/gigamon/imagesRepo).

2. Configure the GigaVUE-FM external server with the GigaVUE-FM IP address.

3. Initiate the upgrade process, select External Image Server, and then specify the path to
the GigaVUE-FM Image file that you added in step 1
(/config/gigamon/imagesRepo/fma5700.imQg).

To upgrade a GigaVUE-FM using internal image files, do the following:

1. Download the images from the Gigamon website and place them where they can be
available for uploading to GigaVUE-FM.

To obtain software images, register on the Gigamon Customer Portal and download
the software.

2. Upload the images file to GigaVUE-FM.

a. On the left navigation pane, cIick and select to System > Images > Internal
Image Files.

b. On the Internal Image File page, click Upload.
c. Click Browse to locate the image file.

d. Click OK to upload the file. The page displays the progress of the upload.

After the upload completes, you can see the GigaVUE-FM image to use for the
upgrade on the Internal Images Files page.

3. Click the Admin drop-down list on the top right of the window and select Upgrade.

4. Onthe FM Image Upgrade page, click in the Image Server field and select Internal
Image Server.
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Software Upgrade

Image File

Select the file server where you have uploaded the image file.

Image Server: Internal Image Server v

Version: <

Image File:

5. From the Version drop-down list, select the version to which you are upgrading.

NOTE: You can only upgrade to another instance of the current version or the
immediate next version. Downgrading to a lower version is not supported
through the UlI.

6. Click Upgrade.

NoTE: When you change the IP address of the GigaVUE-FM instance using the
jump-start configuration, the internal database and the in-memory caches of
the GigaVUE-FM instance are not updated. The Database continues to have the
IP address of the old GigaVUE-FM, and the image upgrade using the internal

server option does not work. To fix this, you must restart the GigaVUE-FM
instance after upgrade.

On the left navigation pane, cIick , to monitor the progress and status of the

upgrade and select Events on the left navigation pane. Also, email notifications are
sent if email notifications have been configured.

After upgrading GigaVUE-FM, you must also upgrade any deployed GigaVUE-VMs.
Otherwise, maps may not work and the GigaVUE-VMs will be unreachable. For
information about upgrading GigaVUE-VM, refer to the “Bulk Upgrading GigaVUE-VM
Nodes” section in the GigaVUE Cloud Suite for VMware—GigaVUE V Series Guide.

NoTE: If you are using FireFox, clear the cache before upgrading to prevent issues
with the browser.
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How to Use the Snapshot Feature

Follow the steps below to upgrade to the current release version of GigaVUE-FM using the
snapshot feature.

E A note about upgrading from very old versions of GigaVUE-FM:

» This procedure is only valid for upgrading from GigaVUE-FM v3.0 and above. For
upgrades from pre-3.0 releases, review the GigaVUE-FM v3.0 User's Guide and
upgrade to release GigaVUE-FM v3.1.

= You cannot directly upgrade from a pre-3.3 releases to the current release. You
can only upgrade from GigaVUE-FM v3.3 or v3.4 release.

1. Prior to upgrading, ensure that the available memory size is at least 8GB prior to
upgrading to the new GigaVUE-FM release. If the available memory size is less than
8GB, it will cause out of memory issues. Also, at least 2 vCPU are required.

2. When upgrading from v3., it's a good idea to use the vSphere client's Snapshot
feature to record the current state of the GigaVUE-FM virtual machine. Steps to use
Snapshot feature are as follows:

a. Log into the vSphere client and navigate to the Datacenter or Cluster level where
the GigaVUE-FM installation is located.

b. Right-click the GigaVUE-FM entry in the vSphere client and select the Take
Snapshot option.

(O vOEA G “ (5 GigaVUEFM22  Actions ~

(G Actions - GigaVVUE-FM22
g Open Console
B [ Poweron
1 Shut Down Guest 08
3 Restart Guest 0S
s Migrate...
ft¢ Take Snapshot. .
r_rZﬂ Revertto Latest Snapshot

{# Manage Snapshots...
28 Clone to Virtual Machine
25 Clone to Template...
{5 Edit Setfings...

Move To..

Rename...
(& AssignTag.
G Remave Tag

Alarms

AllvCenter Actions

jetting Started | Summary  Monitor  Manage

Related Objects

What is a Virtual Machine?

Avirtual machine is a software computer that,
like a physical computer, runs an operating
system and applications. An operating
system installed on a virtual machine is
called a guest operating system.

Because every virtual machine is an isolated
computing environment, you can use virtual
machines as desktop or workstation
environments, as testing environments, or to
consolidate server applications

InvCenter Server, vitual machines run on

hosts or clusters. The same host can run
many virtual machines.

Basic Tasks

[» Power on the virtual machine
W Power off the virtual machine
il Suspend the virtual machine
3 Edit virtual machine settings

Virtual Machines

Cluster [SSs

Host

‘\:] Datacenter

vCenter Server

vSphere Client

Explore Further

Learn how to install a guest
operating system

Learn more about virtual machines
Learn about templates

(]

Figure1 “Take Snapshot” Command to Preserve Current Settings Prior to Upgrade

c. Follow the system prompts to record a snapshot of GigaVUE-FM's current state.
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Installing and Removing System
Components

Safety instructions

NoTE: Whenever you need to lift the system, get others to assist you. To avoid injury,
do not attempt to lift the system by yourself.

WARNING: Opening or removing the system cover while the system is powered on may
expose you to a risk of electric shock.

: Do not operate the system without the cover for a duration exceeding five
minutes. Operating the system without the system cover can result in component damage.

Many repairs may only be done by a certified service technician. You should only
perform troubleshooting and simple repairs as authorized in your product documentation,
or as directed by the online or telephone service and support team. Damage due to
servicing that is not authorized by Dell is not covered by your warranty. Read and follow the
safety instructions that are shipped with your product.

NoOTE: It is recommended that you always use an antistatic mat and antistatic strap
while working on components inside the system.

To ensure proper operation and cooling, all bays in the system and system fans
must be always populated with a component or a blank.

Before working inside your system

1. Follow the safety guidelines listed in Safety instructions.
Turn off the system, including all attached peripherals.

Disconnect the system from the electrical outlet and disconnect the peripherals.

INEININ

Remove the system cover.

After working inside your system

1. Follow the safety guidelines listed in Safety instructions.
2. Install the system cover.

3. Reconnect the peripherals and connect the system to the electrical outlet.

Installing and Removing System Components 30
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4. Turn on the attached peripherals and then turn on the system.

Recommended tools

You need the following tools to perform the removal and installation procedures:
@ Key to the bezel lock.The key is required only if your system includes a bezel.

@ Phillips #1 screwdriver

@ Phillips #2 screwdriver

@ Torx #T30 screwdriver

@®Torx #T8 screwdriver

@® \Wrist grounding strap

Front Bezel (Optional)

This describes the procedure to install and remove the optional Front Bezel.

Removing the front bezel

The procedure to remove the front bezel with and without the LCD panel is the same.

Follow the safety guidelines listed in Safety instructions.

1. Unlock the bezel by using the bezel key.
2. Press the release button, and pull the left end of the bezel.

3. Unhook the right end, and remove the bezel.

Installing the front bezel

The procedure to install the front bezel with and without the LCD panel is the same.
Follow the safety guidelines listed in Safety instructions.

1. Locate and remove the bezel key.

NOTE: The bezel key is part of the LCD bezel package.

Installing and Removing System Components
Front Bezel (Optional)
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2. Align and insert the tabs on the bezel into the slots on the system.
3. Press the bezel until the button clicks in place.

4. Lock the bezel by using the key.

System cover

This describes the procedure to install and remove the System Cover.

Removing the system cover

» Follow the safety guidelines listed in Safety instructions.

e Turn off the system, including any attached peripherals.

» Disconnect the system from the electrical outlet and disconnect the peripherals.

Follow the below steps to remove the System Cover.

1. Using a 1/4 inch flat head or a Phillips #2 screwdriver, rotate the latch release lock counter
clockwise to the unlocked position.

2. Lift the latch till the system cover slides back and the tabs on the system cover disengage
from the guide slots on the system.

3. Hold the cover on both sides, and lift the cover away from the system.
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Installing the system cover

» Follow the safety guidelines listed in Safety instructions.

e Ensure that all internal cables are routed correctly and connected, and no tools or extra
parts are left inside the system.

Follow the below steps to install the System Cover:
1. Align the tabs on the system cover with the guide slots on the system.
2. Push the system cover latch down.

The system cover slides forward, the tabs on the system cover engage with the guide slots
on the system and the system cover latch locks into place.

3. Using a 1/4 inch flat head or Phillips #2 screwdriver, rotate the latch release lock clockwise
to the locked position.

e Reconnect the peripherals and connect the system to the electrical outlet.

e Turn on the system, including any attached peripherals.
Inside the System

Many repairs may only be done by a certified service technician. You should only perform
troubleshooting and simple repairs as authorized in your product documentation, or as
directed by the online or telephone service and support team. Read and follow the safety
instructions that are shipped with your product.
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1.left control panel cable cover

2. hard drive backplane

3. backplane expander board
4. cabling latch

5. air shroud

6. intrusion switch

7. power interposer board

8. internal expansion riser

9. low profile expansion riser 1
10. low profile expansion riser 2
11. processor blank

12. heat sink

13. air shroud

14. cooling fan blank

15. left control panel cable cover

16. information tag

Installing and Removing System Components
Inside the System
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Backplane Cover

This describes the procedure to install and remove the Backplane Cover.

Removing the backplane cover

» Follow the safety guidelines listed in Safety instructions.
» Follow the procedure listed in Before working inside your system.

 Remove the system cover.
Follow the below steps to remove the Backplane Cover.

1. Slide the backplane cover in the direction of the arrows marked on the backplane cover.

2. Lift the backplane cover away from the system.

Installing the backplane cover

» Follow the safety guidelines listed in Safety instructions.
» Follow the procedure listed in Before working inside your system.

* Install the system cover.
Follow the below steps to install the Backplane Cover.
1. Align the tabs on the backplane cover with the guide slots on the system.

2. Slide the backplane cover toward the front of the system until the cover locks into place.

Installing and Removing System Components
Backplane Cover
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Follow the procedure listed in After working inside your system.

Air Shroud

This describes the procedure to install and remove the Air Shroud.

Removing the air shroud

CAUTION: Never operate your system with the air shroud removed. The system may get
overheated quickly, resulting in shutdown of the system and loss of data.

» Follow the safety guidelines listed in Safety instructions.

» Follow the procedure listed in Before working inside your system.
Follow the below steps to remove the Air Shroud:

Holding the blue touch points, lift the air shroud away from the system.

Installing and Removing System Components
Air Shroud
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» Ifapplicable, install the air shroud.

» Follow the procedure listed in After working inside your system.

Installing the air shroud
» Follow the safety guidelines listed in Safety instructions.
» Follow the procedure listed in Before working inside your system.

» If applicable, route the cables inside the system along the system wall and secure the
cables by using the cable latch.

Follow the below steps to install the Air Shroud:
1. Align the tabs on the air shroud with the slots on the system.

2. Lower the air shroud into the system until it is firmly seated. When firmly seated, the
memory socket numbers marked on the air shroud align with the respective memory
sockets.
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Follow the procedure listed in After working inside your system.

Cooling Fans
This describes the procedure to install and remove the Cooling Fan.

Removing the Cooling Fan

» Follow the safety guidelines listed in Safety instructions.

» Follow the procedure listed in Before working inside your system.

¢ Remove the air shroud.
¢ Remove the internal riser.
» Disconnect the fan cable from the system board.

* Move the cables out of the way to access the cooling fan cable connector on the system
board.

Follow the below steps to remove the Cooling Fan:

1. Press the tabs on the side of the cable connector to disconnect the cable from the
connector on the system board.

NOTE: Ensure that you disconnect the fan 1 cable from the power interposer board.

Ensure that you note the routing of the cables as you remove them from the system
board.

2. Lift the fan out holding the blue touch point.
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Installing Cooling Fan

Follow the safety guidelines listed in Safety instructions.

Follow the procedure listed in Before working inside your system.
Remove the air shroud.

Remove the internal riser.

Remove the power cable.

Move the cables out of the way to access the cooling fan cable connector on the system
board.

Follow the below steps to install the Cooling Fan:

1. Holding the blue touch point, place the cooling fan into the cooling fan cage.

2. Route the cooling fan cable and connect it to the connector on the system board.

After installing the Cooling Fan ensure the following:

1. Install the internal riser.

2. Connect the power cable.

3. Ensure all the cables are routed correctly.

4. Install the air shroud.

5. Follow the procedure listed in After working inside your system.

INntrusion Switch

This describes the procedure to install and remove the Intrusion Switch.
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Removing the Intrusion Switch

» Follow the safety guidelines listed in Safety instructions.

e Follow the procedure listed in Before working inside your system.
* Remove air shroud.

¢ Remove internal PERC riser.

Follow the below steps to remove the Intrusion Switch:

1. Disconnect the intrusion switch cable connected to the system board.

NoTE: Ensure that you note the routing of the cables as you remove them from the
system board.

2. Slide the intrusion switch out of the intrusion switch slot.

Installing the intrusion switch

» Follow the safety guidelines listed in Safety instructions.

e Follow the procedure listed in Before working inside your system.
Follow the below steps to install the Intrusion Switch:

1. Align the intrusion switch with the intrusion switch slot.

2. Slide the intrusion switch until it is firmly seated in the intrusion switch slot.
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3. Connect the intrusion switch cable to the connector on the system board.
After installing the Intrusion Switch ensure the following:

1. Install internal PERC riser.

2. Follow the procedure listed in After working inside your system.

Drives

This describes the procedure to install and remove the Drives.

Removing a Drive Blank

» Follow the safety guidelines listed in Safety instructions.

o |finstalled, remove the front bezel.

CAUTION: To maintain proper system cooling, drive blanks must be installed in all empty
drive slots.

CAUTION: Mixing drive blanks from previous generations of PowerEdge servers is not
supported.

Follow the below steps to remove the Drive Blank:

1. Pressthe release button, and slide the drive blank out of the drive slot.

After removing the Drive Blank ensure the following:

1. Install a drive or Installing the hard drive backplane.

Installing a drive blank

» Follow the safety guidelines listed in Safety instructions.

* |finstalled, remove the front bezel.
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CAUTION: Mixing drive blanks from previous generations of PowerEdge servers is not
supported.

Follow the below steps to install the Drive Blank:

1. Insert the drive blank into the drive slot, and push the blank until the release button
clicks into place.

After installing the Drive blank If removed, install the Front Bezel.
Removing a Hard Drive

» Follow the safety guidelines listed in Safety instructions.

» |f applicable, remove the front bezel.

» Using the management software, prepare the hard drive for removal.

If the hard drive is online, the green activity or fault indicator flashes while the drive is
turning off. When the hard drive indicators are off, the hard drive is ready for removal. For
more information, see the documentation for the storage controller.

CAUTION: Before attempting to remove or install a hard drive while the system is
running, see the documentation for the storage controller card to ensure that the host
adapter is configured correctly to support hard drive removal and insertion.

CAUTION: Mixing hard drives from previous generations of PowerEdge servers is not
supported.

CAUTION: To prevent data loss, ensure that your operating system supports drive
installation. See the documentation supplied with your operating system.

Follow the below steps to remove the Hard Drive:

1. Press the release button to open the hard drive release handle.
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2. Holding the handle, slide the hard drive out of the hard drive slot.

After removing the Hard Drive ensure the following:
1. Install a hard drive.

2. If you are not replacing the hard drive immediately, insert a hard drive blank in the empty
hard drive slot to maintain proper system cooling.

Installing a Hard Drive

CAUTION: Before attempting to remove or install a hard drive while the system is
running, see the documentation for the storage controller card to ensure that the host
adapter is configured correctly to support hard drive removal and insertion.

CAUTION: Mixing hard drives from previous generations of PowerEdge servers is not
supported.

CAUTION: Combining SAS and SATA hard drives in the same RAID volume is not
supported.

CAUTION: When installing a hard drive, ensure that the adjacent drives are fully installed.
Inserting a hard drive carrier and attempting to lock its handle next to a partially installed
carrier can damage the partially installed carrier's shield spring and make it unusable.

CAUTION: To prevent data loss, ensure that your operating system supports hot-swap
drive installation. See the documentation supplied with your operating system.
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CAUTION: When a replacement hot swappable drive is installed and the system is
powered on, the drive automatically begins to rebuild. Ensure that the replacement drive
is blank or contains data that you wish to overwrite. Any data on the replacement drive is
immediately lost after the drive is installed.

» Follow the safety guidelines listed in Safety instructions.

» If applicable, remove the hard drive blank.

Follow the below steps to install the Hard Drive:

1. Press the release button on the front of the hard drive carrier to open the release handle.

2. Insert the hard drive carrier into the hard drive slot and slide until the hard drive connects
with the backplane.

3. Close the hard drive carrier release handle to lock the hard drive in place.

After installing the Hard Drive if applicable, install the front bezel.

Removing the Drive from the Drive Carrier

CAUTION: Mixing drives from previous generations of PowerEdge servers is not
supported.

Follow the below steps to remove the Drive from Drive Carrrier:
1. Using a Phillips #1 screwdriver, remove the screws from the slide rails on the drive carrier.

2. Lift the drive out of the drive carrier.
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Installing a drive into the drive carrier

CAUTION: Mixing drive carriers from other generations of PowerEdge servers is not
supported.

NoTeE: When installing a drive into the drive carrier, ensure that the screws are
torqued to 4 in-lbs.

Follow the below steps to install the Drive from Drive Carrier:

1. Insert the drive into the drive carrier with the connector end of the drive towards the back
of the carrier.

2. Align the screw holes on the drive with the screws holes on the drive carrier. When aligned
correctly, the back of the drive is flush with the back of the drive carrier.

3. Using a Phillips #1 screwdriver, secure the drive to the drive carrier with screws.
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System Memory

System memory guidelines

The PowerEdge systems support DDR4 Registered DIMMs (RDIMMs), and Load Reduced
DIMMs (LRDIMMs). System memory holds the instructions that are executed by the
processor.

Your system contains 16 memory sockets. Processor 1 supports up to 10 memory sockets and
Processor 2 supports up to 6 memory sockets. Six memory channels are allocated to each
processor. Processor 1 has four 2 DIMM slots per channel and two 1 DIMM slot per channel,
Processor 2 has six 1 DIMM per channel.

Memory channels are organized as follows:

ks

Table 1: Memory channels

Processor Channel O Channel 1 Channel 2 Channel 3 Channel 4 Channel 5
Processor 1 Slots Al and Slots A2 and Slots A3 Slots A4 and Slots A5 and Slots A6

A7 A8 A9 A10
Processor 2 Slots Bl Slots B2 Slots B3 Slots B4 Slots B5 Slots B6
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Table 2: Memory population

DIMMs Operating Frequency Maximum DIMM Rank/
in MT/s Channel
Populated/ Voltage ( /s)
Channel
RDIMM 1 2666, 2400, 2133, 1866 Dual rank or single rank
1.2V
2 2666, 2400, 2133, 1866 Dual rank or single rank
LRDIMM 1 2666, 2400, 2133, 1866 Quad rank
1.2V
2 2666, 2400, 2133, 1866 Quad rank

General Memory Module Installation Guidelines

To ensure optimal performance of your system, observe the following general guidelines
when configuring your system memory. If your system's memory configurations fail to
observe these guidelines, your system might not boot, stop responding during memory
configuration, or operate with reduced memory.

@ System profile selected (for example, Performance Optimized, or Custom [can be run at
high speed or lower)

@® Maximum supported DIMM speed of the processors.
@® Maximum supported DIMM speed of the processors.

@ Maximum supported speed of the DIMMs

NoTE: MT/s indicates DIMM speed in MegaTransfers per second.

The system supports Flexible Memory Configuration, enabling the system to be configured
and run in any valid chipset architectural configuration. The following are the recommended
guidelines for installing memory modules:

@ All DIMMs must be DDR4.
@®RDIMMs and LRDIMMs must not be mixed.

@64 GB LRDIMMs that are DDP (Dual Die Package) LRDIMMs must not be mixed with 128
GB LRDIMMs that are TSV (Through Silicon Via/3DS) LRDIMMs.

® x4 and x8 DRAM based memory modules can be mixed.

@® Up to two RDIMMs can be populated per channel regardless of rank count.
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@®Up to two LRDIMMSs can be populated per channel regardless of rank count.

® A maximum of two different ranked DIMMs can be populated in a channel regardless of
rank count.

®If memory modules with different speeds are installed, they will operate at the speed of
the slowest installed memory module(s).

® Populate memory module sockets only if a processor is installed.

o For single-processor systems, sockets Al to A10 are available.
o For dual-processor systems, sockets Al to A10 and sockets B1 to B6 are available.

@ Populate all the sockets with white release tabs first, followed by the black release tabs.

@ \When mixing memory modules with different capacities, populate the sockets with
memory modules with the highest capacity first.

NoTE: For example, if you want to mix 8 GB and 16 GB memory modules, populate 16
GB memory modules in the sockets with white release tabs and 8 GB memory
modules in the sockets with black release tabs.

®Memory modules of different capacities can be mixed provided other memory population
rules are followed.

NoTE: For example, 8 GB and 16 GB memory modules can be mixed.

@®In a dual-processor configuration, the memory configuration for each processor must be
identical.

NoTE: For example, if you populate socket Al for processor 1, then populate socket BI
for processor 2, and so on.

@®Mixing of more than two memory module capacities in one system is not supported.

@® Unbalanced memory configurations will result in a performance loss so always populate
memory channels identically with identical DIMMs for best performance.

® Populate six identical memory modules per processor (one DIMM per channel) at a time to
maximize performance. DIMM population update for Performance Optimized mode with
guantity of 4 and 8 DIMMs per processor.

@ \When the DIMM quantity is 4 per processor, the population isslot1, 2, 4, 5.

@ \When the DIMM quantity is 8 per processor, the populationisslot1, 2, 4, 5,7, 8,9, 10.
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Mode-specific guidelines

The configurations allowed depend on the memory mode selected in the System BIOS.

Memory Operating Description

Mode

Optimizer Mode The Optimizer Mode if enabled, the DRAM controllers
operate independently in the 64-bit mode and
provide optimized memory performance.

Mirror Mode The Mirror Mode if enabled, the system maintains two
identical copies of data in memory, and the total
available system memory is one half of the total
installed physical memory. Half of the installed
memory is used to mirror the active memory
modules. This feature provides maximum reliability
and enables the system to continue running even
during a catastrophic memory failure by switching
over to the mirrored copy.

The installation guidelines to enable Mirror Mode
require that the memory modules be identical in size,
speed, and technology, and they must be populated
in sets of 6 per processor.
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Memory Operating Description

Mode

Single Rank Spare Mode Single Rank Spare Mode allocates one rank per
channel as a spare. If excessive correctable errors
occur in a rank or channel, while the operating
system is running, they are moved to the spare area
to prevent errors from causing an uncorrectable
failure.

Requires two or more ranks to be populated in each
channel.

Multi Rank Spare Mode Multi Rank Spare Mode allocates two ranks per
channel as a spare. If excessive correctable errors
occur in a rank or channel, while the operating
system is running, they are moved to the spare area
to prevent errors from causing an uncorrectable
failure.

Requires three or more ranks to be populated in each
channel.

With single rank memory sparing enabled, the
system memory available to the operating system is
reduced by one rank per channel.

For example, in a dual-processor configuration with
sixteen 16 GB dual-rank memory modules, the
available system memory: 16 GB x 16(memory
modules) - 8GB(1 rank sparing/channel) x

12(channel) = 256 GB - 96 GB =160 GB. For multi rank
sparing, in a dual-processor configuration with
sixteen 64 GB quad-rank memory modules, the
available system memory:

64 GB x 16(memory modules) - 32 GB(2 rank
sparing/channel) x 12 (channel) = 1024 GB - 384 GB =
640 GB.

NOTE: To use memory sparing, this feature must be
enabled in the BIOS menu of System Setup.

NOTE: Memory sparing does not offer protection
against a multi-bit uncorrectable error.

Dell Fault Resilient Mode The Dell Fault Resilient Mode if enabled, the BIOS
creates an area of memory that is fault resilient. This
mode can be used by an OS that supports the feature
to load critical applications or enables the OS kernel
to maximize system availability.

This feature is only supported in Gold and Platinum
Intel processors.

Memory configuration has to be of same size DIMM,
speed, and rank.
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Optimizer Mode

This mode supports Single Device Data Correction (SDDC) only for memory modules that
use x4 device width. It does not impose any specific slot population requirements.

® Dual processor: Populate the slots in round robin sequence starting with processor 1.

NOTE: Processor 1and processor 2 population should match.

Processor Configuration Memory Memory
population population

information

Single Optimizer (Independent channel) population 1,2,3,4,56,7,8, | ®@Populate in this
processor order 9,10 order, odd amount
allowed.

@® Odd number of
DIMM population is
allowed.

NoTe: NOTE: Odd
number of DIMMs
will result in
unbalanced memory
configurations, which
in turn will result in
performance loss. It is
recommended to
populate all memory
channels identically
with identical DIMMs
for best performance.

@Optimizer population
order is not traditional
for 4 and 8 DIMM
installations of single
processor.

o For 4 DIMMs: AT,
A2, A4, AS

o For 8 DIMMs: Al,
A2, A4, A5, A7, A8,

A9, A10
Mirror population order 1,23, 4,5 6} Mirroring is supported
with 6 DIMM slots per
processor.
Single rank sparing population order 1,2,3,4,56,7,8, | Populate in this order,
9,10 odd amount allowed.

Requires two ranks or
more per channel.
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Processor Configuration

Memory
population

Memory
population
information

Multi rank sparing population order

1,2,3,4,56,7,8,
9,10

Populate in this order,
odd amount allowed.
Requires three ranks or
more per channel.

Dual processor | Optimized (Independent channel) population
(Populate order

round robin
starting with
processorl)

Afl}, BT} A2}, B
{2}, A3}, B{3}..

@®0Odd amount of
DIMM slots per
processor allowed.

@ Odd number of
DIMM population is
allowed.

NoTe: NOTE: Odd
number of DIMMs
will result in
unbalanced memory
configurations, which
in turn will result in
performance loss. It is
recommended to
populate all memory
channels identically
with identical DIMMs
for best performance.

@® Optimizer
population order is not
traditional for 8 and 14
DIMM installations of
dual processor.

O  For 8 DIMMs: Al,

A2, A4, A5, Bl, B2, B4,

B5

(@) For 14 DIMMs: Al,
A2, A4, A5, A7, A8, A9,

A10, B1, B2, B3, B4, B5,
B6
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Processor Configuration Memory Memory
population population

information

Mirroring population order Afl, 2,3, 4,5,6}, Mirroring is supported
B{l, 2, 3, 4, with 6 DIMM slots per
5, 6} processor.
Single rank sparing population order A1}, B{1}, A2}, B | Populate in this order,
{2}, A3} odd amount per
B{3}.. processor allowed.
Requires
two ranks or more per
channel.
Multi rank sparing population A1}, B{1}, A{2}, B | Populate in this order,
order {2}, A3}, odd amount per
B{3}... processor allowed.
Requires

three ranks or more per
channel.

Processors and heat sinks

This describes the procedure to install and remove Processors and Heat Sinks.

WARNING: The heat sink may be hot to touch for some time after the system is powered
down. Allow the heat sink to cool before removing it.

» Follow the safety guidelines listed in Safety instructions.
e Follow the procedure listed in Before working inside your system.

« |f applicable, remove the air shroud.

Removing Processor and Heat Sink Module

Follow the below steps to remove a Processor and Heat Sink module:

1. Using a Torx #T30 screwdriver, loosen the screws on the heat sink in the order below:
a. Loosen the first screw three turns.
b. Loosen the second screw completely.

c. Return to the first screw and loosen it completely.

2. Pushing both blue retention clips simultaneously, lift the processor and heat sink module
(PHM) processor and heat sink module
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3. Set the PHM aside with the processor side facing up.

Installing a Processor and Heat Sink Module

CAUTION: Never remove the heat sink from a processor unless you intend to replace the
processor. The heat sink is necessary to maintain proper thermal conditions.

» Follow the safety guidelines listed in Safety instructions.
» Ifinstalled, remove the processor blank and CPU dust cover.
Follow the below steps to install a Processor and Heat Sink module:

1. Align the pin 1indicator of the heat sink to the system board and then place the processor
and heat sink module (PHM) on the processor socket.

CAUTION: To avoid damaging the fins on the heat sink, do not press down on the heat
sink fins.

NoOTE: Ensure that the PHM is held parallel to the system board to prevent damaging
the components.

2. Push the blue retention clips inward to allow the heat sink to drop into place.

3. Using the Torx #T30 screwdriver, tighten the screws on the heat sink in the order below:

a. Partially tighten the first screw (approximately 3 turns).
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b. Tighten the second screw completely.

c. Return to the first screw and tighten it completely.
4.If the PHM slips off the blue retention clips when the screws are partially tightened, follow
these steps to secure the PHM:

a. Loosen both the heat sink screws completely.

b. Lower the PHM on to the blue retention clips, following the procedure described in
step 2.

c. Secure the PHM to the system board, following the replacement instructions listed
in this step above.

NOTE: The processor and heat sink module retention screws should not be tightened
to more than 0.13 kgf-m (1.35N.m or 12 in-1bf).

After installing the Processor Heat Sink Module follow the procedure listed in After working
inside your system.

Removing the Processor from the Processor and Heat Sink Module

NoTE: Only remove the processor from the processor and heat sink module if you are
replacing the processor or heat sink. This procedure is not required when replacing a
system board.

» Follow the safety guidelines listed in Safety instructions.

e Follow the procedure listed in Before working inside your system.
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¢ Remove the air shroud.

¢ Remove the processor and heat sink module.

Follow the below steps to remove a Processor from a Processor and Heat Sink module:
1. Place the heat sink with the processor side facing up.

2. Insert a flat blade screwdriver into the release slot marked with a yellow label. Twist (do
not pry) the screwdriver to break the thermal paste seal.

3. Push the retaining clips on the processor bracket to unlock the bracket from the heat sink.

4. Lift the bracket and the processor away from the heat sink, and place the processor
connector side down on the processor tray.

5. Flex the outer edges of the bracket to release the bracket from the processor.

NoTE: Ensure that the processor and the bracket are placed in the tray after you
remove the heat sink.

Installing the Processor into a Processor and Heat Sink Module

e Follow the safety guidelines listed in Safety instructions

Follow the below steps to install a Processor from a Processor and Heat Sink module:

1. Place the processor in the processor tray.

NOTE: Ensure that the pin 1indicator on the processor tray is aligned with the pin 1
indicator on the processor.

2. Flex the outer edges of the bracket around the processor ensuring that the processor is
locked into the clips on the bracket.
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NoTE: Ensure that the pin 1indicator on the bracket is aligned with the pin1
indicator on the processor before placing the bracket on the processor.

NoTE: Ensure that the processor and the bracket are placed in the tray before you
install the heat sink.

3. If you are using an existing heat sink, remove the thermal grease from the heat sink by
using a clean lint-free cloth.

4. Use the thermal grease syringe included with your processor kit to apply the grease in a
quadrilateral design on the top of the processor.

CAUTION: Applying too much thermal grease can result in excess grease coming in
contact with and contaminating the processor socket.

NoTE: The thermal grease syringe is intended for single use only. Dispose the syringe
after you use it.
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5. Place the heat sink on the processor and push down on the base of the heat sink until the
bracket locks onto the heat sink.

NoTE: @Ensure that the two guide pin holes on the bracket match the guide holes
on the heat sink. ® Do not press on the heat sink fins. ®@Ensure that the pin 1indicator
on the heat sink is aligned with the pin 1indicator on the bracket before placing the

heat sink onto the processor and bracket.

Internal PERC riser

This describes the procedure to install and remove the Internal PERC Riser.

Removing the internal PERC riser

NoTE: The new generation PERC 11 H750, H350, and HBA350i adapters cannot be
mixed with the PERC H740P, H730P, H330, HBA330 adapters of the previous
generations in one system. For more information, see Cable routing.

» Follow the safety guidelines listed in Safety instructions.

* Follow the procedure listed in Before working inside your system.

e Remove the air shroud.

Follow the below steps to remove the Internal PERC Riser:
1. Open the cable guiding latch for easy access.

2. Lower the plunger.

3. Press the cable connector and disconnect the PERC cable from the backplane.
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4. Hold the blue touch points and lift the internal PERC riser out of the system.

5. Turn the internal riser so that the PERC card is facing up.

6. Press the cable connector and disconnect the cable that is connected to the internal
PERC card

After removing the Internal PERC riser you can do the following :
1. Install the air shroud.
2. Follow the procedure listed in After working inside your system.

3. Install the internal PERC card.

Installing the Internal PERC Riser

NoTE: The new generation PERC 11 H750, H350, and HBA350i adapters cannot be
mixed with the PERC H740P, H730P, H330, HBA330 adapters of the previous
generations in one system. For more information, see Cable routing.

» Follow the safety guidelines listed in Safety instructions.
Follow the below steps to install the Internal PERC Riser:

1. Connect the cable to the internal PERC card.

Installing and Removing System Components
Internal PERC riser

59



GigaVUE-FM Hardware Appliance Guide for GFM-HW1-FMO10 and GFM-HW1-FMOOIT-HW

2. Holding the blue touch points, align the slot on the internal PERC riser to the guide on the
system board.

3. Insert the internal riser card’s edge connector firmly into the system board connector until
the riser is fully seated.

4. Lift the plunger to lock the riser in place.

5. Connect the cables to the backplane and then route the cables to the cable guiding latch
to close the latch.

After installing the Internal PERC Riser you could do the following:

1. Install the air shroud.

2. Follow the procedure listed in After working inside your system.

Removing the PERC card from the internal PERC riser
e Follow the safety guidelines listed in Safety instructions.

* Follow the procedure listed in Before working inside your system.

e Remove the air shroud.

¢ Remove the internal PERC riser.
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Follow the below steps to remove the PERC card from the Internal PERC Riser:

1. Using a Phillips #2 screwdriver, remove the screw that secures the PERC card to the
internal PERC riser.

2. Pull the PERC card out of the connector on the internal PERC riser.

After removing the PERC card from the Internal PERC Riser you could do the following:
1. Install the PERC card into the internal PERC riser.
2. Replace the air shroud.

3. Follow the procedure listed in After working inside your system.

Installing PERC card into the Internal PERC riser

» Follow the safety guidelines listed in Safety instructions.

Follow the below steps to install the PERC card from the Internal PERC Riser:
1. Insert the PERC card into the internal PERC riser and push the card in.

2. Using a Phillips #2 screwdriver, replace the screw to secure the PERC card on the internal
PERC riser.
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After installing the PERC card from the Internal PERC Riser you could do the following:
1. Install the internal PERC riser.
2. Install the air shroud.

3. Follow the procedure listed in After working inside your system.

Expansion cards and expansion card risers

NOTE: A System Event Log (SEL) event is logged if an expansion card riser is not
supported or missing. It does not prevent your system from turning on. However, if a
F1/F2 pause occurs, an error message is displayed.

Expansion Card Installation Guidelines

Depending on your system configuration, the following PCIl Express (PCle) generation 3
expansion cards are supported:

Table 3: Expansion card riser configurations

Expansion card PCle slots on the Height Length Link
riser riser

LOM riser Slot 1 Mezz type Mezz type x8
Right riser Slot 2 Low Profile | Half Length | x16
Right riser Slot 2 Full Height | Half Length | x16
PCle passive bridge Slot-integrated Low Profile | Half Length | x8
Internal riser Slot-integrated Low Profile | Half Length | x8
Left riser Slot 3 Low Profile | Half Length | x16
NoOTE: The expansion card slots are not hot-swappable.
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The following table provides guidelines for installing expansion cards to ensure proper

cooling and mechanical fit. The expansion cards with the highest priority should be installed
first using the slot priority indicated. All the other expansion cards should be installed in the

card priority and slot priority order.

Table 4: Riser configurations: No riser

Card Type

Slot

Priority

From
Factor

PERC9.14G(Foxconn) Integrated Slot | Low Profile
RAID - PERC9.14G/PERCIO (Internal)/ PERCI1 (Dell) | Integrated Slot | Low Profile
Non-RAID - PERC 11 (Internal) (Dell) Integrated Slot | Low Profile
1Gb NIC Foxconn 1 OCP

Table 5: Riser configurations: FH (Full Height riser*1)

Card Type Slot Form
Priority Factor

PERC9.14G (Foxconn) 2 Full Height
PERC9.14G (Foxconn) Integrated Slot | Low Profile
RAID - PERC9.14G/PERCIO (Internal)/ PERCI1 (Dell) | Integrated Slot | Low Profile
Non-RAID - PERC 11 (Internal) (Dell) Integrated Slot | Low Profile
Non-RAID - PERC 11 (External) (Dell) 2 Full Height
RAID PERCI0 (External) (Dell) 2 Full Height
NVMe PCle SSD (Samsung, Intel) 2 Full Height
1G NICs (Broadcom) 2 Full Height
10G NICs (Broadcom) 2 Full Height
25G NICs (Broadcom) 2 Full Height
1G NICs (Intel) 2 Full Height
10G NICs (Intel) 2 Full Height
25G NICs (Intel) 2 Full Height
40G NICs (Intel) 2 Full Height
FC8 HBA (Emulex) 2 Full Height
FCl6 HBA (Emulex) 2 Full Height
InfiniBand HCA FDR (Mellanox) 2 Full Height
10G NICs (Mellanox) 2 Full Height
25G NICs (Mellanox) 2 Full Height
40G NICs (Mellanox) 2 Full Height
100G NICs (Mellanox) 2 Full Height
FC8 HBA (QLogic) 2 Full Height
FC16 HBA (QLogic) 2 Full Height
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Card Type Slot Form
Priority Factor

10G NICs (QLogic) 2 Full Height
25G NICs (QLogic) 2 Full Height
Ompni-Path HFI (Intel) 2 Full Height
10G NICs (Solarflare) 2 Full Height
25G NICs (Solarflare) 2 Full Height
1 Gb NIC (Broadcom) 1 OCP

10 Gb NIC (Broadcom) 1 OCP

25 Gb NIC (Broadcom) 1 OCP
HWRAID BOSS 2 Full Height

Table 6: Riser configurations: LP (Low Profile riser*])

Card Type

Slot

Priority

PERC9.14G (Foxconn) Integrated Slot | Low Profile
HBA: External adapter (Dell) 3 Low Profile
RAID - PERC9.14G/PERCIO (Internal)/ PERCI1 (Dell) | Integrated Slot | Low Profile
Non-RAID - PERC 11 (Internal) (Dell) Integrated Slot | Low Profile
Non-RAID - PERC 11 (External) (Dell) 3 Low Profile
PERC 10 External adapter (Dell) 3 Low Profile
RAID PERCIO (External) (Dell) 3 Low Profile
NVMe PCle SSD (Samsung, Intel) 3 Low Profile
1G NICs (Broadcom) 3 Low Profile
10G NICs (Broadcom) 3 Low Profile
25G NICs (Broadcom) 3 Low Profile
1G NICs (Intel) 3 Low Profile
10G NICs (Intel) 3 Low Profile
25G NICs (Intel) 3 Low Profile
40G NICs (Intel) 3 Low Profile
FC8 HBA (Emulex) 3 Low Profile
FC16 HBA (Emulex) 3 Low Profile
InfiniBand HCA FDR (Mellanox) 3 Low Profile
10G NICs (Mellanox) 3 Low Profile
25G NICs (Mellanox) 3 Low Profile
40G NICs (Mellanox) 3 Low Profile
100G NICs (Mellanox) 3 Low Profile
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Card Type Slot Form
Priority Factor
FC8 HBA (QLogic) 3 Low Profile
FC16 HBA (QLogic) 3 Low Profile
10G NICs (QLogic) 3 Low Profile
25G NICs (QLogic) 3 Low Profile
Omni-Path HFI (Intel) 3 Low Profile
10G NICs (Solarflare) 3 Low Profile
25G NICs (Solarflare) 3 Low Profile
1 Gb NIC (Broadcom) 1 OCP
10 Gb NIC (Broadcom) 1 OCP
25 Gb NIC (Broadcom) 1 OCP
HWRAID BOSS 3 Low Profile

Table 7: Riser configurations: LP+LP (Low Profile riser*2)

Card Type

Slot

Priority

PERC9.14G (Foxconn) Integrated Slot | Low Profile
HBA: External adapter (Dell) 3,2 Low Profile
RAID - PERC9.14G/PERCIO (Internal)/ PERCI1 (Dell) | Integrated Slot | Low Profile
Non-RAID - PERC 11 (Internal) (Dell) Integrated Slot | Low Profile
Non-RAID - PERC 11 (External) (Dell) 32 Low Profile
PERC 10 External adapter (Dell) 3,2 Low Profile
RAID PERCI10 (External) (Dell) 3,2 Low Profile
NVMe PCle SSD (Samsung, Intel) 32 Low Profile
1G NICs (Broadcom) 32 Low Profile
10G NICs (Broadcom) 3,2 Low Profile
25G NICs (Broadcom) 3,2 Low Profile
1G NICs (Intel) 32 Low Profile
10G NICs (Intel) 32 Low Profile
25G NICs (Intel) 3,2 Low Profile
40G NICs (Intel) 3,2 Low Profile
FC8 HBA (Emulex) 32 Low Profile
FCl6 HBA (Emulex) 32 Low Profile
InfiniBand HCA FDR (Mellanox) 3,2 Low Profile
10G NICs (Mellanox) 3,2 Low Profile
25G NICs (Mellanox) 32 Low Profile
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Card Type Slot Form
Priority Factor

40G NICs (Mellanox) 32 Low Profile
100G NICs (Mellanox) 3,2 Low Profile
FC8 HBA (QLogic) 3,2 Low Profile
FCl6 HBA (QLogic) 3,2 Low Profile
10G NICs (QLogic) 32 Low Profile
25G NICs (QLogic) 3,2 Low Profile
Ompni-Path HFI (Intel) 3,2 Low Profile
10G NICs (Solarflare) 3,2 Low Profile
25G NICs (Solarflare) 32 Low Profile
1 Gb NIC (Broadcom) 1 OCP

10 Gb NIC (Broadcom) 1 OCP

25 Gb NIC (Broadcom) 1 OCP

HWRAID BOSS 3,2 Low Profile

Table 8: Riser configurations: LP+LP+NVMe Bridge (Low Profile riser*2)

Card Type Slot Form

Priority Factor

PERC9.14G (Foxconn) 3 Low Profile
HBA: External adapter (Dell) 2 Low Profile
RAID - PERC9.14G/PERCIO (Internal)/ PERCTI (Dell) | 3 Low Profile
Non-RAID - PERC 11 (Internal) (Dell) 3 Low Profile
Non-RAID - PERC 11 (External) (Dell) 2 Low Profile
PERC 10 External adapter (Dell) 2 Low Profile
RAID PERCIO (External) (Dell) 2 Low Profile
NVMe PCle SSD (Samsung, Intel) 2 Low Profile
1G NICs (Broadcom) 2 Low Profile
10G NICs (Broadcom) 2 Low Profile
25G NICs (Broadcom) 2 Low Profile
1G NICs (Intel) 2 Low Profile
10G NICs (Intel) 2 Low Profile
25G NICs (Intel) 2 Low Profile
40G NICs (Intel) 2 Low Profile
FC8 HBA (Emulex) 2 Low Profile
FC16 HBA (Emulex) 2 Low Profile
InfiniBand HCA FDR (Mellanox) 2 Low Profile
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Card Type Slot Form
Priority Factor

10G NICs (Mellanox) 2 Low Profile
25G NICs (Mellanox) 2 Low Profile
40G NICs (Mellanox) 2 Low Profile
100G NICs (Mellanox) 2 Low Profile
FC8 HBA (QLogic) 2 Low Profile
FC16 HBA (QLogic) 2 Low Profile
10G NICs (QLogic) 2 Low Profile
25G NICs (QLogic) 2 Low Profile
Omni-Path HFI (Intel) 2 Low Profile
10G NICs (Solarflare) 2 Low Profile
25G NICs (Solarflare) 2 Low Profile
1 Gb NIC (Broadcom) 1 OCP

10 Gb NIC (Broadcom) 1 OCP

25 Gb NIC (Broadcom) 1 OoCP

HWRAID BOSS 2 Low Profile

Expansion bus specifications

The GigaVUE-FM Hardware Appliance system supports PCl express (PCle) generation three

expansion cards, which must be installed on the system board using expansion card risers.

The R440 system supports four types of expansion card risers.

e LOM riser - One x8 PCle Gen 3 for OCP form factor cards - connected to Processor]

e Rightriser - One x16 PCle Gen3 for low-profile half-length cards or One x16 PCle Gen3 for

full height half-length cards - connected to Processor]

» Left riser - One x16 PCle Gen3 for low-profile half-length cards - connected to Processor2

* Internal riser - One x8 PCle Gen3 for low-profile half-length cards - connected to

Processorl

Table 9: Expansion card riser configurations

Expansion card PCle slots on the Height Length Link
riser riser

LOM riser Slot 1 Mezz type Mezz type x8
Right riser Slot 2 Low Profile | Half Length | x16
Right riser Slot 2 Full Height | Half Length | x16
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Expansion card PCle slots on the Height Length Link
riser riser

PCle passive bridge Slot-integrated Low Profile | Half Length | x8
Internal riser Slot-integrated Low Profile | Half Length | x8
Left riser Slot 3 Low Profile | Half Length | x16

Installing an expansion card riser

» Follow the safety guidelines listed in Safety instructions.

Follow the below steps to install an Expansion Card Riser:

1. If removed, install the expansion cards into the expansion card riser.

2. Holding the touch points, align the slot on the riser with the guide in the system board.

3. Lower the expansion card riser into place until the expansion card riser connector is fully
seated in the connector.
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After installing the expansion card riser you could do the following:

1. Follow the procedure listed in After working inside your system.

2. Install any device drivers required for the card as described in the documentation for the
card.

Removing an expansion card riser

» Follow the safety guidelines listed in Safety instructions.
e Follow the procedure listed in Before working inside your system.
» Disconnect any cables connected to the expansion card.

Follow the below steps to remove an Expansion Card Riser:

Hold the touch points, and lift the expansion card riser, from the riser connector, on the
system board.
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Removing the Expansion card from the Expansion Card Riser

Follow the safety guidelines listed in Safety instructions.

Follow the procedure listed in Before working inside your system.

If applicable, remove the air shroud.

Remove the expansion card riser.

If applicable, disconnect the cables from the expansion card.

Follow the below steps to remove an Expansion Card from the Expansion Card Riser:
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1. Open the PCle card holder latch.

2. Hold the expansion card by its edges, and pull the card until the card edge connector
disengages from the expansion card connector on the riser.

3. Install a filler bracket if you are not replacing the expansion card.

NOTE: You must install a filler bracket over an empty expansion card slot to maintain
Federal Communications Commission (FCC) certification of the system. The brackets
also keep dust and dirt out of the system and aid in proper cooling and airflow inside
the system.
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Follow the below steps to remove an Expansion Card from Expansion Card Riser:

Install the expansion card riser.

Installing the Expansion Card into the Expansion Card Riser
» Follow the safety guidelines listed in Safety instructions.

» Ifinstalling a new expansion card, unpack it and prepare the card for installation.

NOTE: For instructions, see the documentation accompanying the card.

« Remove the expansion card riser.

Follow the below steps to install an Expansion Card from the Expansion Card Riser:

1. Open the PCle card holder latch.

2. If installed, remove the filler bracket.

NoTE: Store the filler bracket for future use. Filler brackets must be installed in empty
expansion card slots to maintain Federal Communications Commission (FCC)
certification of the system. The brackets also keep dust and dirt out of the system and
aid in proper cooling and airflow inside the system.
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3. Hold the card by its edges, and align the card edge connector with the expansion card
connector on the riser.

4. Insert the card edge connector firmly into the expansion card connector until the card is
fully seated.

5. Close the expansion card latch.

Follow the below steps to remove an Expansion Card from Expansion Card Riser:
1. If applicable, connect the cables to the expansion card.
2. Install the expansion card riser

3. If applicable, install the air shroud.
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4. Follow the procedure listed in After working inside your system.

5. Install any device drivers required for the card as described in the documentation for the
card.

M.2 SSD module

NoOTE: The write-protect switch is on the IDSDM or vFlash module.

Installing the M.2 SSD module

» Follow the safety guidelines listed in Safety instructions

e Remove the air shroud.

e Remove the BOSS card.

NOTE: The procedure to remove the BOSS card is similar to the removing an
expansion card.

Follow the below steps to install a M.2 SSD module:
1. Connect the M.2 SSD module to the connector on the BOSS card.

2. Place the retention strap on the M.2 SSD module, and tighten the screw to secure the
module.

After installing the M.2 SSD module you could do the following:

1. Install the BOSS card.

NoOTE: The procedure to install the BOSS card is similar to the removing an
expansion card.
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2. Install the air shroud.
3. Follow the procedure listed in After working inside your system.

Removing the M.2 SSD module

Follow the safety guidelines listed in Safety instructions.

Follow the procedure listed in Before working inside your system.

Remove the air shroud.

Remove the BOSS card.

NOTE: The procedure to remove the BOSS card is similar to the removing an
expansion card.

Follow the below steps to remove a M.2 SSD module:

1. Loosen the screw and lift the retention strap that secures the M.2 SSD module on the
BOSS card.

2. Lift the M.2 SSD module and slide it out of the connector on the BOSS card

After removing the M.2 SSD module you could do the following:

1. Replace the M.2 SSD module.
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Optional MicroSD or vFlash card

Removing the MicroSD card
» Follow the safety guidelines listed in Safety instructions.
» Follow the procedure listed in Before working inside your system.

Follow the below steps to remove a MicroSD card:

1. Locate the MicroSD card slot on the vFlash/IDSDM module, and press the card to partially
release it from the slot. To locate IDSDM/vFlash module, see the System board jumpers and

connectors section.

2. Hold the MicroSD card and remove it from the slot.

NoTE: Temporarily label each MicroSD card with its corresponding slot number after
removal.

After removing the MicroSD card you could do the following:

1. Follow the procedure listed in After working inside your system.
2. Install a MicroSD card.

Installing the MicroSD card

» Follow the safety guidelines listed in Safety instructions.

NOTE: To use an MicroSD card with your system, ensure that the Internal SD Card
Port is enabled in System Setup.
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NoTE: If reinstalling, ensure that you install the MicroSD cards into the same slots
based on the labels you had marked on the cards during removal.

Follow the below steps to install a MicroSD card:

1. Locate the MicroSD card connector on the IDSDM/vFlash module. Orient the MicroSD card
appropriately and insert the contact-pin end of the card into the slot. To locate
IDSDM/VFlash, see the System board jumpers and connectors section.

NOTE: The slot is keyed to ensure correct insertion of the card.

2. Press the card into the card slot to lock it into place.

After installing the MicroSD card you could do the following:

1. Follow the procedure listed in After working inside your system.

Optional IDSDM or vFlash module

Removing the Optional IDSDM or vFlash card
» Follow the safety guidelines listed in Safety instructions.
» Follow the procedure listed in Before working inside your system.

» Ifyou are replacing the IDSDM/vFlash card, remove the MicroSD cards.

NoTE: Temporarily label each MicroSD card with its corresponding slot number after
removal.

Follow the below steps to remove a Optional IDSDM or vFlash card:
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1. Locate the IDSDM/vFlash connector on the system board.

To locate IDSDM/vFlash connector, see the System board jumpers and connectors section.

2. Holding the pull tab, lift the IDSDM/vFlash card out of the system.

NoTE: There are two dip switches on the IDSDM/vFlash card for write-protection.

After removing the IDSDM/VFlash card you could do the following:

1. Install the optional IDSDM/vFlash card.

Installing optional IDSDM or vFlash card

e Follow the safety guidelines listed in Safety instructions.
Follow the below steps to install a IDSDM/vFlash card:

1. Locate the IDSDM/vFlash connector on the system board.

NoTE: To locate IDSDM/vFlash connector, see the Jumpers and connectors section.

2. Align the IDSDM/vFlash card with the connector on the system board.

3. Push the IDSDM/vFlash card until it is firmly seated on the system board.
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After installing the IDSDM/vFlash card you could do the following:

1. Install the MicroSD cards.

NoTE: Reinstall the MicroSD cards into the same slots based on the labels you had
marked on the cards during removal.

2. Follow the procedure listed in After working inside your system .

LOM riser card

Removing the LOM riser card

» Follow the safety guidelines listed in Safety instructions.
» Follow the procedure listed in Before working inside your system.

o |finstalled, remove the risers.
Follow the below steps to remove the LOM riser card:

1. Using a Phillips #2 screwdriver, loosen the screws that secure the LOM riser card to the
system board.

2. Release the two blue side plastic snaps holding the LOM riser card.

3. Hold the LOM riser card by the edges on either side, and lift to remove it from the
connector on the system board.

4. Slide the LOM riser card towards the front of the system until the Ethernet connectors or
the Small form-factor pluggable (SFP) are clear of the slot in the back of the system.
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After removing the LOM riser card you could do the following:

e |nstall the LOM riser card.

Installing the LOM riser card

» Follow the safety guidelines listed in Safety instructions

Follow the below steps to install the LOM riser card:

1. Align the connectors on the LOM riser card with the slot on the system.

2. Press the LOM riser card until the card is firmly seated on the system board connector and
the two blue plastic snap hold the LOM riser card in place.

3. Using a Phillips #2 screwdriver, replace the screws to secure the LOM riser card to the
system board.

After installing the LOM riser card you could do the following:
e |f removed, install the risers.

» Follow the procedure listed in After working inside your system.
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Hard drive backplane

Hard drive backplane details

Depending on your system configuration, the hard drive backplanes supported in hardware

appliance are listed here:

Supported hard drives options

GigaVUE-FM Hardware Appliance | 2.5-inch (x8) SAS, SATA or Nearline SAS drives

Figure1 8x25-inch backplane

1.Release tab

2. SATA_A cable connector

3. backplane signal cable connector
4. backplane

5. SATA_B cable connector

6. backplane power cable connector

Installing the hard drive backplane

» Follow the safety guidelines listed in Safety instructions.

NoTE: The procedure to install the backplane is similar for all backplane
configurations.

Follow the below steps to install the hard drive backplane:
1. Align the slots on the backplane with the hooks on the system.
2. Lower the hard drive backplane until the blue release tabs snap into place.

3. If your backplane has an expander board, then tighten the captive screws to secure the
expander board to the system.
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After installing the hard drive backplane you could do the following:
e Connect all the cables to the backplane.

Install all the hard drives.

Install the backplane cover.

Install the air shroud.

Follow the procedure listed in After working inside your system

Removing the Hard Drive backplane

CAUTION: To prevent damage to the drives and backplane, remove the hard drives from
the system before removing the backplane.

CAUTION: Note the number of each hard drive and temporarily label them before you
remove the hard drive so that you can replace them in the same location.

NoTe: NOTE: The procedure to remove the backplane is similar for all backplane
configurations.

» Follow the safety guidelines listed in Safety instructions.
» Follow the procedure listed in Before working inside your system.
e Remove the air shroud.

« Remove the backplane cover.
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* Remove all hard drives from the hard drive slot.
» Disconnect all the cables from the backplane.
Follow the below steps to remove the hard drive backplane:

1. Press the blue release tabs and lift the backplane to disengage the backplane from the

hooks on the system.

2. To remove a backplane with an expander board:
a. Loosen the captive screws that secure the expander board.

Press the release tabs and lift the backplane to disengage the slots on the
backplane from the hooks on the system.

a.

3. Lift the backplane out of the system.
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Cable Routing

Cable routing - 8 x 2.5 hard drive backplane with PERC riser

1 2 3 4 5 & 7

1.Hard drive backplane

2. Backplane power cable

3. SAS cable (SAS_A and SAS_B cable connectors to internal riser)
4. Backplane signal cable

5. Cable routing clip

6. Power interposer board

7. Internal PERC

8. System board
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Cable routing - 8 x 2.5 hard drive backplane with onboard SATA.

1 2345 6 7 8

1.hard drive backplane

2. backplane power cable

3. SATA cable (BP: SATA_B to MB)
4, SATA cable (BP: SATA_A to MB)
5. backplane signal cable

6. cable routing clip

7. power interposer board

8. system board

System Battery

The GigaVUE-FM Hardware Appliance ver 2.0 supports CR 2032 3.0-V lithium coin cell
system battery.

Replacing the system battery

WARNING: There is a danger of a new battery exploding if it is incorrectly installed.
Replace the battery only with the same or equivalent type recommended by the
manufacturer. For more information, see the safety information that shipped with your
system.
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» Follow the safety guidelines listed in Safety instructions.

» Follow the procedure listed in Before working inside your system.

» |f applicable, disconnect the power or data cables from expansion card(s).
Follow the below steps to remove and install the System Battery:

1. Locate the battery socket. For more information, see the Jumpers and Connectors section.

CAUTION: To avoid damage to the battery connector, you must firmly support the
connector while installing or removing a battery.

2. Use a plastic scribe to pry out the system battery.

3. To install a new system battery, hold the battery with the positive side facing up and slide
it under the securing tabs.

4. Press the battery into the connector until it snaps into place.

You could do the following after successfully installing the system battery
» |f applicable, connect the cables to the expansion card(s).
» Follow the procedure listed in After working inside your system.

¢ While booting, press F2 to enter the System Setup and ensure that the battery is
operating properly.
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» Enter the correct time and date in the System Setup Time and Date fields.

e EXit the System Setup.

Optional internal USB memory key

NOTE: To locate the internal USB port on the system board, see the Jumpers and
Connectors section.

Replacing the optional internal USB memory key

CAUTION: To avoid interference with other components in the server, the maximum

permissible dimensions of the USB memory key are 159 mm wide x 5715 mm long x 7.9
mm high.

» Follow the safety guidelines listed in Safety instructions.
» Follow the procedure listed in Before working inside your system.
Follow the below steps to replace the optional Internal USB Memory Key:

1. Locate the USB port or USB memory key on the system board. To locate the USB port, see
the Jumpers and connectors.

2. If installed, remove the USB memory key from the USB port.

3. Insert the replacement USB memory key into the USB port.

Follow the below steps after replacing the optional Internal USB Memory Key:
1. Follow the procedure listed in After working inside your system.

2. While booting, press F2 to enter System Setup and verify that the system detects the USB
memory key.

Optical drive (optional)

Removing the optical drive

» Follow the safety guidelines listed in Safety instructions.

e Follow the procedure listed in Before working inside your system.
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» Ifapplicable, remove the front bezel.

» Disconnect the power and data cables from the connectors on the optical drive.

NoTE: Ensure that you note the routing of the power and data cable on the side of
the system and drive. Route these cables properly when you replace them to prevent

them from being pinched or crimped.

Follow the below steps to remove the optional Optical Drive:
1. Press the release tab to release the optical drive.
2. Slide the optical drive out of the system until it is out of the optical drive slot.

3. If you are not adding a new optical drive, install the optical drive blank. The procedure to
install the optical drive blank is the same as the optical drive.

Installing the optical drive

» Follow the safety guidelines listed in Safety instructions.

Follow the below steps to install the optional Optical Drive:

1. Align the optical drive with the optical drive slot on the front of the system.

2.Slide in the optical drive until the release tab snaps into place.
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3. Connect the power and data cables to the connector on the optical drive.

NoOTE: Route the cable properly to prevent it from being pinched or crimped.

4. Replace the front Bezel.

After installing the Optical Drive follow the procedure listed in After working inside your
system

Power supply units

NoOTE: For more information, see the PowerEdge R440 Technical Specs at
www.dell.com/poweredgemanuals.

CAUTION: If two PSUs are installed, both the PSUs must have the same type of label. For
example,

Extended Power Performance (EPP) label. Mixing PSUs from previous generations of
PowerEdge servers is not supported, even if the PSUs have the same power rating. Mixing
PSUs will result in mismatch condition or failure to turn the system on.

NoTeE: When two identical PSUs are installed, power supply redundancy (1+1 — with
redundancy or 2+0 — without redundancy) is configured in system BIOS. In redundant
mode, power is supplied to the system equally from both PSUs when Hot Spare is
disabled. When Hot Spare is enabled, one of the PSUs is put into the sleep mode
when system utilization is low in order to maximize efficiency.

NoTE: If two PSUs are used, they must be of the same maximum output power.

Removing a Power Supply unit blank
» Follow the safety guidelines listed in Safety instructions.
Follow the below steps to remove the Power Supply Unit blank:

If you are installing a second power supply unit, remove the power supply unit blank in the
bay by pulling the blank outward.

CAUTION: To ensure proper system cooling, the power supply unit blank must be
installed in the second power supply unit bay in a non-redundant configuration. Remove
the power supply unit blank only if you are installing a second power supply unit.
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Installing a Power Supply Unit blank

» Follow the safety guidelines listed in Safety instructions.

NoTE: Install the power supply unit (PSU) blank only in the second PSU bay.

Follow the below steps to install the Power Supply Unit blank:

1. Align the PSU blank with the PSU slot and push it into the PSU slot until it clicks into
place.

After installing a Power Supply Unit follow the procedure listed in After working inside your
system.

Removing a Power Supply Unit

CAUTION: The system needs one power supply unit (PSU) for normal operation. On

power-redundant systems, remove and replace only one PSU at a time in a system that is
powered on.

» Follow the safety guidelines listed in Safety instructions.

e Disconnect the power cable from the power source and from the PSU you intend to
remove, and then remove the cable from the strap on the PSU handle.

» Unlatch and lift the optional cable management arm if it interferes with the PSU removal.
Follow the below steps to remove the Power Supply Unit blank:

1. Press the release latch and slide the PSU out of the system by using the PSU handle.
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Installing a Power Supply Unit

» Follow the safety guidelines listed in Safety instructions

» For systems that support redundant PSU, ensure that both the PSUs are of the same type
and have the same maximum output power.

NOTE: The maximum output power (shown in watts) is listed on the PSU label.

Follow the below steps to install the Power Supply Unit :

1. Slide the PSU into the system until the PSU is fully seated and the release latch snaps
into place.

1. If you have unlatched the cable management arm, relatch it.

2. Connect the power cable to the PSU, and plug the cable into a power outlet.

CAUTION: When connecting the power cable to the PSU, secure the cable to the PSU
with the strap.
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NoTE: When installing, hot swapping, or hot adding a new PSU, wait for 15 seconds
for the system to recognize the PSU and determine its status. The PSU redundancy
may not occur until discovery is complete. Wait until the new PSU is discovered and
enabled before you remove the other PSU. The PSU status indicator turns green to
signify that the PSU is functioning properly.

Removing a non-redundant cabled AC power supply unit

Follow the safety guidelines listed in Safety instructions.

Follow the procedure listed in Before working inside your system.
Remove the air shroud

Disconnect the system from the electrical outlet.

Disconnect all the cables connected from the PSU to the system board.

If applicable, remove the expansion card riser.

Follow the below steps to remove a non-redundant cabled AC power supply unit:

1.

2.

Using a Phillips #2 screwdriver, remove the screw securing the PSU to the system.

Slide the PSU out of the PSU cage.

Installing a non-redundant cabled AC power supply unit

Follow the safety guidelines listed in Safety instructions.

Follow the below steps to install a non-redundant cabled AC power supply unit:

1.

2.

3.

Unpack the new power supply unit (PSU).
Slide the new PSU into the PSU cage until the PSU is fully seated.

Using a Phillips #2 screwdriver, replace the screw to secure the PSU to the system.
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After installing you do the following:
1. Connect the PSU cables to the connectors on the system board.
2. If applicable, install the expansion card riser.

3. Install the air shroud.

4. Follow the procedure listed in After working inside your system.

Power interposer board

Removing power interposer board

Follow the safety guidelines listed in Safety instructions.

Follow the procedure listed in Before working inside your system.

Remove the air shroud

Disconnect all the cables connected from the PIB to the system board.

NoTE: Ensure that you note the routing of the cables as you remove them from the
system board.

* Remove the PSU.
Follow the below steps to remove the Interposer Board:

1. Using a Phillips #2 screwdriver, remove the two screws securing the Power Interposer
Board (PIB) to the system.

2. Lift the board and slide it out at an angle to disengage the guide pins on the board.
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3. Lift the board away for the system.

Installing power interposer board

» Follow the safety guidelines listed in Safety instructions.

Follow the below steps to install the Interposer Board:

1. Align the slots on the PIB with the guides on the system.

2. Using a Phillips #2 screwdriver, replace the two screws to secure the PIB to the system.

3. Route the cables and connect it to the system board.

After installing the Interposer Board you could do the following:
1. Install the PSU.
2. Install the air shroud.

3. Follow the procedure listed in After working inside your system.
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Control panel

Removing the left control panel

Follow the safety guidelines listed in Safety instructions.

Follow the procedure listed in Before working inside your system.

Remove the air shroud.

Remove the internal PERC riser.

Follow the below steps to remove the left Control Panel:

1. Disconnect the control panel cable from the system board connector.

the cables from being pinched or crimped.

NoTE: Ensure that you note the routing of the cables as you remove them from the
system board. You must route the cables properly when you replace them to prevent

2. Using a Phillips #1 screwdriver, remove the screws that secure the cable cover.

system.

4. Holding by the sides, remove the left control panel assembly away from the system.
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Installing the left control panel

» Follow the safety guidelines listed in Safety instructions.

Follow the below steps to install the left Control Panel:

1. Route the control panel cable through the side wall of the system.

2. Align the left control panel assembly with the control panel slot on the system and place
the assembly in the slot on the system.

3. Connect the control panel cable to the system board connector.

4. Using Phillips #1 screwdriver, install the screws that secure the cable cover to the system.

¥

>

After installing the left control panel you could do the following:
1. Follow the safety guidelines listed in Safety instructions.

2. Install the air shroud.

3. Install the internal PERC riser.

4. Follow the procedure listed in Before working inside your system.

Removing the Right Control Panel

» Follow the safety guidelines listed in Safety instructions.
e Follow the procedure listed in Before working inside your system.
* Remove the internal PERC riser.

Follow the below steps to remove the right Control Panel:

1. Lift the cable latch and disconnect the control panel cable from the connector on the
system board.
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NoOTE: Ensure that you note the routing of the cables as you remove them from the
system board. You must route the cables properly when you replace them to prevent
the cables from being pinched or crimped.

2. Using a Phillips #1 screwdriver, remove the screws that secure the cable cover to the
system.

system.

4. Holding the control panel by its sides, remove the control panel away from the system.

Installing the right control panel

» Follow the safety guidelines listed in Safety instructions.

Follow the below steps to install the right Control Panel:

1. Route the control panel cable through the side wall of the system.

2. Align the right control panel with the control panel slot on the system and place the
assembly in the slot on the system.
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3. Connect the control panel cable to the connector on the system board and lower the
cable latch to secure the cable in place.

4. Using a Phillips #1 screwdriver, install the screws that secure the cable cover to the
system.

After installing the right control panel you could do the following:
1. Install the internal PERC riser.

2. Follow the procedure listed in After working inside your system.

System Board

Removing the System Board

CAUTION: If you are using the Trusted Platform Module (TPM) with an encryption key, you
may be prompted to create a recovery key during program or System Setup. Be sure to
create and safely store this recovery key. If you replace this system board, you must
supply the recovery key when you restart your system or program before you can access
the encrypted data on your hard drives.

CAUTION: Do not attempt to remove the TPM plug-in module from the system board.
Once the TPM plug-in module is installed, it is cryptographically bound to that specific
system board. Any attempt to remove an installed TPM plug-in module breaks the
cryptographic binding, and it cannot be re-installed or installed on another system board.

» Follow the safety guidelines listed in Safety instructions.
» Follow the procedure listed in Before working inside your system.

¢ Remove the following:

Air shroud
All expansion cards and risers
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Internal PERC riser

IDSDM/vFlash module card
Internal USB key (if installed)
Processors and heat sink modules
Memory modules

LOM riser card

Follow the below steps to remove the System Board:

1. Disconnect all cables from the system board.

NoTE: Ensure that you note the routing of the cables as you remove them from the
system board.

CAUTION: Take care not to damage the system identification button while removing the
system board from the chassis.

CAUTION: Do not lift the system board by holding a memory module, processor, or other
components.

2. Using a Phillips #2 screwdriver, remove the screws that secure the system board to the
chassis.

3. Hold the system board holder, slightly lift the system board, and then slide it toward the
front of the chassis.

4. Using the system board holder, lift the system board out of the chassis.

Installing the System Board

» Follow the safety guidelines listed in Safety instructions.
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Follow the below steps to install the System Board:

1. Unpack the new system board assembly.

CAUTION: Do not lift the system board by holding a memory module, processor, or other
components.

CAUTION: Take care not to damage the system identification button while placing the
system board into the chassis.

2. Holding the system board holder, align the connector on the system board with the slots
on the back of the chassis and place the system board in place.

3. Using a Phillips #2 screwdriver, replace the screws that secure the system board to the
chassis.

After installing the system board you could do the following:

1. Replace the following:

a. Install the Trusted Platform Module (TPM).

b. Internal PERC riser
c. Internal USB key (if applicable)
d. USB 3.0 module (if applicable)
e. IDSDM/vFlash module card
f. All expansion cards and risers
g. Processors and heat sink modules
h. Processors blanks (if applicable)
i. Memory modules
Installing and Removing System Components 100

System Board



GigaVUE-FM Hardware Appliance Guide for GFM-HW1-FMO10 and GFM-HWI1-FMOO1-HW

j. LOMriser card
k. Air shroud

2. Reconnect all cables to the system board.

NoTe: NOTE: Ensure that the cables inside the system are routed along the chassis
wall and secured using the cable securing bracket.

3. Follow the procedure listed in Before working inside your system.

4, Ensure that you:

a. Use the Easy Restore feature to restore the Service Tag. For more information, see
the Restoring the Service Tag by using the Easy Restore feature section.

b. If the Service Tag is not backed up in the backup flash device, enter the Service Tag
manually. For more information, see the Restoring the Service Tag by using the
Easy Restore feature section.

c. Update the BIOS and iDRAC versions.

d. Re-enable the Trusted Platform Module (TPM). For more information, see the
Upgrading the Trusted Platform Module section.

5. Import your new or existing iDRAC Enterprise license.

Restoring the system using Easy Restore

The easy restore feature enables you to restore your service tag, license, UEFI configuration,
and the system configuration data after replacing the system board. All data is backed up in
a backup flash device automatically. If BIOS detects a new system board, and the service tag
in the backup flash device, BIOS prompts the user to restore the backup information.

You can do the following tasks:
@ Restore the service tag, license, and diagnostics information, press Y
® Navigate to the Lifecycle Controller based restore options, press N.

@ Restore data from a previously created Hardware Server Profile, press F10

NoTE: When the restore process is complete, BIOS prompts to restore the system
configuration data.

@®To restore the system configuration data, press Y

@®To use the default configuration settings, press N
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NoTeE: NOTE: After the restore process is complete, system reboots.

Manually update the Service Tag

After replacing a system board, if Easy Restore fails, follow this process to manually enter the
Service Tag, using System Setup.

If you know the system service tag, use the System Setup menu to enter the service tag.
Follow the below steps:

1. Power on the system.
2. To enter the System Setup, press F2.
3. Click Service Tag Settings.

4, Enter the service tag.

NOTE: You can enter the service tag only when the Service Tag field is empty. Ensure
that you enter the correct service tag. Once the service tag is entered, it cannot be
updated or changed.

5. Click OK.

Entering the system Service Tag by using System Setup

If Easy Restore fails to restore the Service Tag, use System Setup to enter the Service
Tag.Follow the below steps:

1. Turn on the system.
2. Press F2 to enter System Setup.
3. Click Service Tag Settings.

4. Enter the Service Tag.

NOTE: You can enter the Service Tag only when the Service Tag field is empty. Ensure
that you enter the correct Service Tag. After the Service Tag is entered, it cannot be
updated or changed.

5. Click OK.

6. Import your new or existing iDRAC Enterprise license.
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Trusted Platform Module

Upgrading the Trusted Platform Module

» Follow the safety guidelines listed in Safety instructions.

» Follow the procedure listed in Before working inside your system.

NoOTE:

1. Ensure that your operating system supports the version of the TPM module being
installed.

2. Ensure that you download and install the latest BIOS firmware on your system.

3. Ensure that the BIOS is configured to enable UEFI boot mode.

CAUTION: If you are using the Trusted Platform Module (TPM) with an encryption key, you
may be prompted to create a recovery key during program or System Setup. Work with
the customer to create and safely store this recovery key. When replacing this system
board, you must supply the recovery key when you restart your system or program before
yOou can access the encrypted data on your hard drives.

CAUTION: Once the TPM plug-in module is installed, it is cryptographically bound to that
specific system board. Any attempt to remove an installed TPM plug-in module breaks
the cryptographic binding, the removed TPM cannot be reinstalled or installed on
another system board.

Removing the TPM

To remove the TPM follow the below steps:
1. Locate the TPM connector on the system board.

2. Press to hold the module down and remove the screw using the security Torx 8-bit
shipped with the TPM module.

3. Slide the TPM module out from its connector.

4. Push the plastic rivet away from the TPM connector and rotate it 90° counterclockwise to
release it from the system board.

5. Pull the plastic rivet out of its slot on the system board.
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Installing the TPM

To install the TPM follow the below steps:

1. To install the TPM, align the edge connectors on the TPM with the slot on the TPM
connector.

2. Insert the TPM into the TPM connector such that the plastic rivet aligns with the slot on
the system board.

3. Press the plastic rivet until the rivet snaps into place.

After installing the TPM do the following:
1. Install the system board.

2. Follow the procedure listed in After working inside your system.

Initializing TPM for BitLocker users

e [nitialize the TPM.

« The TPM Status changes to Enabled, Activated.

Initializing the TPM 1.2 for TXT users

Follow the below steps to initialize the TPM:

1. While booting your system, press F2 to enter System Setup.

2. 0n the System Setup Main Menu screen, click System BIOS > System Security Settings.
3. From the TPM Security option, select On with Pre-boot Measurements.

4. From the TPM Command option, select Activate.

5. Save the settings.

6. Restart your system.
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7. Enter System Setup again.
8. On the System Setup Main Menu screen, click System BIOS > System Security Settings.

9. From the Intel TXT option, select On.
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Jumpers and Connectors

This topic provides specific information about the jumpers and switches and describes the

connectors on the board in the system. Jumpers on the system board help to disable the

system and setup passwords. You must know the connectors on the system board to install

components and cables correctly.

10 11 12 13 141516 1718 19 20 21

Item

22 23 24

Connector

Description

1. FANG Cooling fan 6 connector

2. CPU1 Processor socket 1

3. CPUI_PWR_CONN(P2) CPUT power connector

4. J_INTRU Intrusion switch connector

5. J_BP_SIC1 Backplane signal connector 1

6. LFT_CP_CONN Left control panel connector

7. J_SATA_BI Internal SATA B connector

8. RGT_CP_CONN Right panel connector

9. SYS_PWR_CONN(P1) System power connector

10. J_PIB_SIGI Power interposer board signal connector 1
. J_PIB_SIG2 Power interposer board signal connector 2
12. J_ACE Internal Dual SD Module

Jumpers and Connectors
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Item Connector Description
13. J_CP_USB2 Front USB connector
14. J_SATA_AI Internal SATA A connector
15. J_SATA_CI Internal SATA C connector
16. PCIE_G3_X8(CPUT) Internal PERC controller connector
17. J_REAR_BP_PWRI Rear backplane power connector
18. J_FRONT_VIDEO VGA connector
19. INT_USB_3.0 USB connector
20. NVRAM_CLR Clear NVRAM
21. PWRD_EN Reset BIOS password
22. SLOTS PCle slot 5
23. SLOT4 PCle slot 4
24. SLOT3 PCle slot 3
25. J_TPM_MODULE TPM module connector
26. J_BP_SIGO Backplane signal connector
27. J_MEZZ_Al LOM riser card connector
28. BATTERY Battery connector
29. PCIE_G3_X16(CPUT) Riser 1 connector
30. AG, A5, A10, A4, A9, A7, Al, A8, A2, A3 | Memory module sockets
31 B3, B2, Bl1, B4, B5, B6 Memory module sockets
32. CPU2 Processor socket 2
33. PCIE_AO NVMe connector
34. CPU2_PWR_CONN(P3) CPU2 power connector

System board jumper settings

For information on resetting the password jumper to disable a password, see the Disabling a

forgotten password section.

Disabling forgotten password

The software security features of the system include a system password and a setup
password. The password jumper enables or disables password features and clears any

password(s) currently in use.

Jumpers and Connectors
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CAUTION: Many repairs may only be done by a certified service technician. You should
only perform troubleshooting and simple repairs as authorized in your product
documentation, or as directed by the online or telephone service and support team.
Damage due to servicing that is not authorized by Dell is not covered by your warranty.
Read and follow the safety instructions that are shipped with your product.

Follow the below steps to disable forgotten password.

1. Power off the system, including any attached peripherals, and disconnect the system from
the electrical outlet.

2. Remove the system cover.
3. Move the jumper on the system board jumper from pins 2 and 4 to pins 4 and 6.
4. Install the system cover.

The existing passwords are not disabled (erased) until the system boots with the jumper on
pins 4 and 6. However, before you assign a new system and/or setup password, you must
move the jumper back to pins 2 and

NoTE: If you assign a new system and/or setup password with the jumper on
pins 4 and 6, the system disables the new password(s) the next time it boots.

5. Reconnect the system to its electrical outlet and power on the system, including any
attached peripherals.

6. Power off the system, including any attached peripherals, and disconnect the system from
the electrical outlet.

7. Remove the system cover.
8. Move the jumper on the system board jumper from pins 4 and 6 to pins 2 and 4.
9. Install the system cover.

10. Reconnect the system to its electrical outlet and power on the system, including any
attached peripherals.

11. Assign a new system and/or setup password.
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Using System Diagnostics

If you experience a problem with your system, run the system diagnostics before contacting
Gigamon for technical assistance. The purpose of running system diagnostics is to test your
system hardware without requiring additional equipment or risking data loss. If you are
unable to fix the problem yourself, service and support personnel can use the diagnostics
results to help you solve the problem.

Embedded System Diagnostics

NoTeE: NOTE: The Embedded System Diagnostics is also known as Enhanced Pre-
boot System Assessment (ePSA) diagnostics.

The embedded system diagnostics provides a set of options for particular device groups or
devices allowing you to:

- Run tests automatically or in an interactive mode
- Repeat tests
- Display or save test results

- Run thorough tests to introduce additional test options to provide extra information about
the failed device(s)

- View status messages that inform you if tests are completed successfully

- View error messages that inform you of problems encountered during testing

When to use the Embedded System Diagnostics

If a major component or device in the system does not operate properly, running the
embedded system diagnostics may indicate component failure.

Running the Embedded System Diagnostics from Boot Manager
1. As the system boots, press <F11>.

2. Use the up and down arrow keys to select System Utilities > Launch Diagnostics.
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STEP RESULT: The ePSA Pre-boot System Assessment window is displayed, listing all
devices detected in the system. The diagnostics starts executing the tests on all the
detected devices.

Running the Embedded System Diagnostics from the Lifecycle Controller
1. As the system boots, press <F11>.

2. Select Hardware Diagnostics ? Run Hardware Diagnostics.

STEP RESULT: The ePSA Pre-boot System Assessment window is displayed, listing all
devices detected in the system. The diagnostics starts executing the tests on all the
detected devices.

System diagnostic controls

Menu Description

Configuration Displays the configuration and status information of all detected devices.

Results Displays the results of all tests that are executed.

System health Provides the current overview of the system performance.

Event log Displays a time-stamped log of the results of all tests run on the system. This is displayed
if at least one event description is recorded.

Using System Diagnostics 10
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Cetting Help

Contacting Gigamon

Gigamon provides several online and telephone-based support and service options. If you do
not have an active Internet connection, you can find contact information on your purchase
invoice, packing slip, bill, or product catalog.

Availability varies by country and product, and some services may not be avail- able in your
area. To contact Gigamon for sales, technical support, or customer-service issues:

1. For support, go to gigamon.com/support-and-services/contact-support.

2. For sales, inside.sales@gigamon.com or +1 408-831-4025

Locating your system Service Tag

Your system is identified by a uniqgue Express Service Code and Service Tag number. The
Express Service Code and Service Tag are found on the front of the system by pulling out the
information tag. Alternatively, the information may be on a sticker on the chassis of the
system. This information is used by Gigamon to route support calls to the appropriate
personnel.

Getting Help 1M
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Additional Sources of Information

This appendix provides additional sources of information. Refer to the following sections for
details:

« Documentation

= Documentation Feedback

« Contact Technical Support

« Contact Sales

« The Gigamon Community

Documentation

This table lists all the guides provided for GFM-HW1-FMO10,GFM-HW1-FMOOT-HW software
and hardware. The first row provides an All-Documents Zip file that contains all the guides in
the set for the release.

NoTE: In the online documentation, view What's New to access quick links to topics
for each of the new features in this Release; view Documentation Downloads to
download all PDFs.

Table 1: Documentation Set for Gigamon Products

GFM-HW1-FMO010,GFM-HW1-FM0O0O1-HW 6.1 Hardware and Software Guides

DID YOu KNOoW? [f you keep all PDFs for a release in common folder, you can easily search across the doc set
by opening one of the files in Acrobat and choosing Edit > Advanced Search from the menu. This opens an
interface that allows you to select a directory and search across all PDFs in a folder.

Hardware

how to unpack, assemble, rack-mount, connect, and initially configure ports the respective GFM-HW1-
FMO010,GFM-HW1-FMOO1-HW devices; reference information and specifications for the respective GFM-HW1-
FMO10,GFM-HW1-FMOO1-HW devices

GigaVUE-HC1 Hardware Installation Guide

GigaVUE-HC2 Hardware Installation Guide

GigaVUE-HC3 Hardware Installation Guide

GigaVUE-HCI1-Plus Hardware Installation Guide

GigaVUE-TA25E Hardware Installation Guide

GigaVUE-TA200E Hardware Installation Guide

GigaVUE-TA25 Hardware Installation Guide

Additional Sources of Information -|-|2
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GFM-HW1-FMO010,GFM-HW1-FMO001-HW 6.1 Hardware and Software Guides

GigaVUE-TA200 Hardware Installation Guide

GigaVUE-TA400 Hardware Installation Guide

GigaVUE-TA10 Hardware Installation Guide

GigaVUE-TA40 Hardware Installation Guide

GigaVUE-TA100 Hardware Installation Guide

GigaVUE-TA100-CXP Hardware Installation Guide

GigaVUE-OS Installation Guide for DELL S4112F-ON

G-TAP A Series 2 Installation Guide

GigaVUE M Series Hardware Installation Guide

GigaVUE-FM Hardware Appliance Guide for GFM-HW1-FM010 and and GFM-HW1-FMOO1-HW

Software Installation and Upgrade Guides

GigaVUE-FM Installation, Migration, and Upgrade Guide

GigaVUE-OS Upgrade Guide

GigaVUE V Series Migration Guide

Fabric Management and Administration Guides

GigaVUE Administration Guide
covers both GigaVUE-OS and GigaVUE-FM

GigaVUE Fabric Management Guide

how to install, deploy, and operate GigaVUE-FM; how to configure GigaSMART operations; covers both
GigaVUE-FM and GigaVUE-OS features

Cloud Guides

how to configure the GigaVUE Cloud Suite components and set up traffic monitoring sessions for the cloud
platforms

*GigaVUE V Series Applications Guide

GigaVUE V Series Quick Start Guide

GigaVUE Cloud Suite for AWS-GigaVUE V Series 2 Guide

GigaVUE Cloud Suite for Azure-GigaVUE V Series 2 Guide

GigaVUE Cloud Suite for OpenStack-GigaVUE V Series 2 Guide

*GigaVUE Cloud Suite for Nutanix Guide—GigaVUE V Series 2 Guide

GigaVUE Cloud Suite for VMware—GigaVUE V Series Guide

Additional Sources of Information -|-|3
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GFM-HW1-FMO010,GFM-HW1-FMO001-HW 6.1 Hardware and Software Guides

*GigaVUE Cloud Suite for Third Party Orchestration

GigaVUE Cloud Suite for AnyCloud Guide

Universal Container Tap Guide

Gigamon Containerized Broker Guide

GigaVUE Cloud Suite for AWS-GigaVUE V Series 1 Guide

GigaVUE Cloud Suite for Azure-GigaVUE V Series 1 Guide

GigaVUE Cloud Suite for OpenStack-GigaVUE V Series 1 Guide

GigaVUE Cloud Suite for Nutanix Guide—GigaVUE-VM Guide

GigaVUE Cloud Suite for VMware—GigaVUE-VM Guide

Reference Guides

GigaVUE-OS CLI Reference Guide

library of GigaVUE-OS CLI (Command Line Interface) commands used to configure and operate GigaVUE
HC Series and TA Series devices

GigaVUE-OS Cabling Quick Reference Guide
guidelines for the different types of cables used to connect Gigamon devices

GigaVUE-OS Compatibility and Interoperability Matrix
compatibility information and interoperability requirements for Gigamon devices

GigaVUE-FM REST API Reference in GigaVUE-FM User's Guide
samples uses of the GigaVUE-FM Application Program Interfaces (APIs)

Release Notes

GigaVUE-OS, GigaVUE-FM, GigaVUE-VM, G-TAP A Series, and GigaVUE Cloud Suite Release Notes
new features, resolved issues, and known issues in this release ;
important notes regarding installing and upgrading to this release

NoTE: Release Notes are not included in the online documentation.

NoTE: Registered Customers can log in to My Gigamon to download the Software and Release Notes
from the Software & Docs page on to My Gigamon. Refer to How to Download Software and Release
Notes from My Gigamon.

In-Product Help

GigaVUE-FM Online Help
how to install, deploy, and operate GigaVUE-FM.
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How to Download Software and Release Notes from My Gigamon

Registered Customers can download software and corresponding Release Notes documents
from the Software & Release Notes page on to My Gigamon. Use the My Gigamon Software
& Docs page to download:

¢ Gigamon Software installation and upgrade images,
» Release Notes for Gigamon Software, or
» Older versions of PDFs (pre-v5.7).

To download release-specific software, release notes, or older PDFs:

1. Log in to My Gigamon
2. Click on the Software & Release Notes link.

3. Use the Product and Release filters to find documentation for the current release. For
example, select Product: "GigaVUE-FM" and Release: "5.6," enter "pdf" in the search box,
and then click GO to view all PDF documentation for GigaVUE-FM 5.6.xx.

NoTE: My Gigamon is available to registered customers only. Newer documentation
PDFs, with the exception of release notes, are all available through the publicly
available online documentation.

Documentation Feedback

We are continuously improving our documentation to make it more accessible while
mMaintaining accuracy and ease of use. Your feedback helps us to improve. To provide
feedback and report issues in our documentation, send an email to:
documentationfeedback@gigamon.com

Please provide the following information in the email to help us identify and resolve the
issue. Copy and paste this form into your email, complete it as able, and send. We will
respond as soon as possible.

Documentation Feedback Form

Your Name

About You Your Role

Your Company

Additional Sources of Information -|-|5
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Online doc link

(URL for where the issue is)

For Online Topics

Topic Heading

(if it's a long topic, please provide the heading of the
section where the issue is)

Document Title

(shown on the cover page or in page header )

Product Version

(shown on the cover page)

For PDF Topics Document Version

(shown on the cover page)

Chapter Heading

(shown in footer)

PDF page #

(shown in footer)

Describe the issue

Describe the error or issue in the documentation.

(If it helps, attach an image to show the issue.)

How can we improve

the content?
How can we

improve? Be as specific as

possible.

Any other
comments?

Contact Technical Support

For information about Technical Support: Go to Settings > Support > Contact Support

in GigaVUE-FM.

You can also refer to https://www.gigamon.com/support-and-services/contact-support for

Technical Support hours and contact information.

Email Technical Support at support@gigamon.com.

Additional Sources of Information
Contact Technical Support
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Contact Sales

Use the following information to Gigamon channel partner or Gigamon sales
representatives.

Telephone: +1.408.831.4025
Sales: inside.sales@gigamon.com

Partners: www.gigamon.com/partners.html

Premium Support

Email Gigamon at inside.sales@gigamon.com for information on purchasing 24x7 Premium
Support. Premium Support entitles you to round-the-clock phone support with a dedicated
Support Engineer every day of the week.

The Gigamon Community

The Gigamon Community is a technical site where Gigamon users, partners, security and
network professionals and Gigamon employees come together to share knowledge and
expertise, ask questions, build their network and learn about best practices for Gigamon
products.

Visit the Gigamon Community site to:

» Find knowledge base articles and documentation
« Ask and answer guestions and learn best practices from other members.

» Join special-interest groups to have focused collaboration around a technology, use-
case, vertical market or beta release

» Take online learning lessons and tutorials to broaden your knowledge of Gigamon
products.

« Submit and vote on feature enhancements and share product feedback. (Customers
only)

« Open support tickets (Customers only)
» Download the latest product updates and documentation (Customers only)

The Gigamon Community is a great way to get answers fast, learn from experts and
collaborate directly with other members around your areas of interest.

Register today at community.gigamon.com

Questions? Contact our Community team at community@gigamon.com.
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Glossary

D
decrypt list
need to decrypt (formerly blacklist)
decryptlist
need to decrypt - CLI Command (formerly blacklist)
drop list
selective forwarding - drop (formerly blacklist)
F

forward list

selective forwarding - forward (formerly whitelist)

L
leader

leader in clustering node relationship (formerly master)
M

member node

follower in clustering node relationship (formerly slave or non-master)

N

no-decrypt list

no need to decrypt (formerly whitelist)
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nodecryptlist

no need to decrypt- CLI Command (formerly whitelist)

P

primary source

root timing; transmits sync info to clocks in its network segment (formerly grandmaster)

R

receiver

follower in a bidirectional clock relationship (formerly slave)

S

source

leader in a bidirectional clock relationship (formerly master)
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